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FROM THE EDITORS

INFORMATION IS POWER

Edgin gave me a call and asked if I'd

be interested in becoming Editor of
Keyframe Magazine. Now, it's two years
later and we've come a long way. HDRI
3D has not only been extremely well
received by the 3D community, many
people are surprised at how much they
like it. All of us here at HDRI 3D thank you
for your support, your ideas, and your comments. One or two
of you have written in about the style of the magazine without
much enthusiasm, and that's OK. Remember my last editorial?
Same thing applies here — you can't please all the people all
the time. Regardless, I do appreciate hearing from all of you
and the publishers and | discuss each and every comment. We
laugh at some of them, but we discuss them just the samel
Just kidding! Seriously — thanks for emailing and keep it up.

I t seems like just the other day, Charles

]
/

4

DAN ABLAN
EDITOR-IN-CHIEF

\

I've been out of the loop a bit lately working with some
new exciting software that | plan to cover in the magazine.
It's all related to 3D and useful to your hobby or business.
This new magazine format gives us the freedom to explore
all the possibilities of this 3D world we work in every day.
from the emails I've received, even the hardest of hardcore
LightWave users are finding that reading tutorials from
other applications can spark ideas. Additionally, you may find
that certain applications we cover in the magazine are not
something you've considered using, but by reading through
a tutorial on it, you may find that it can help your workflow.

Never close any doors, especially when it comes to your
creativity. Be a sponge and soal it all up. Information is power.

L. ot

EDITOR-IN-CHIEF

_/

LATEST HAPPENINGS IN
THE SOFTIMAGE|XSI

COMMUNITY
or quite some time,
SOFTIMAGE|XSI  was

one of the most expensive
3D packages on the market,
and while many people were
impressed by the fast work-
flow and the diverse toolset
of the software, they argued
that the package was simply
out of their price range and they couldn't afford it. Some
people even asked for a special “freelancer” version in the
hope to get a hold of it. A few months ago at Siggraph 2004
in Los Angeles, Avid announced 3-Democracy and dropped
the price dramatically. SOFTIMAGE|XSI Foundation got the
new price of 4955 and became one of the cheapest pack-
ages on the market. The other versions of SOFTIMAGE|XSI,
Essentials and Advanced, got through the price reduction at
even a slightly lower pricing than their main competitor, Alias
Maya Complete and Unlimited.

RAFFAEL DICKREUTER
SOFTIMAGE|XSI EDITOR

The trend that started a few years ago continued; 3D
software became much more affordable, allowing literally
everybody to get their hands on it.

The next surprise came along, by the end of 2004,
when version 4.2 was released. Essentials started
shipping with the XSI Compositor, called FX Tree, when
before it had only been available in the Advanced version.
XSI Advanced started to include SOFTIMAGE|Behavior,
the crowd simulation software that until then was only
available as a stand-alone product for 13'0008. With that,
XS| Advanced became the only 3D package to include
crowd simulation software.

Avid has done a lot to please its users in the past year
and to increase its user base. To what extent these efforts
will be successful to get more of a market share remains
to be seen, but the effort is there to make the product
appealing to a wide variety of 3D artists and no longer
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just larger production houses. With XSI Foundation, the
people now can get their “freelancer” version.

A highlight product created using SOFTIMAGE|XSI is
Half Life 2. When Valve's highly anticipated game was
released after several months of delay last November,
SOFTIMAGE released the XSI ModTool, which allows
gamers to create their own characters and assets for the
game. The ModTool is basically an updated version of
XSI EXP, the free demo version of SOFTIMAGE|XSI. That
tool might also have quite a bit of potential if it will support
a broad range of game formats; however, if the amount
of available exporters remains limited, the ModTool will
lose popularity once the hype of a supported game starts
to drop and the enthusiastic gamers move on to the next
challenge that isn't supported.

The past year showed great progress for the
SOFTIMAGE|XSI community as a whole. More user
groups started to pop up around the world. Australia,
Brazil, Japan, London, Montreal, Vancouver, Austria,
and even Hawaii, as well as San Diego and New York
City, all had user group events. A new user group for
Los Angeles was just announced and will have its first
meeting in March.

In January, a new consulting company called CG
Soup was founded. Their focus is providing pipeline
consulting services and custom tool development for
SOFTIMAGE|XSI. The company was formed by industry
veterans and SOFTIMAGE|XS!| experts Kim Aldus,
Bradley Gabe, and Maggie Kathwaroon. The name of
the company is based on CG Supervisors, also called
CG Supes.

SOFTIMAGE|XSI ARTICLES IN HDRI MAGAZINE

Scripting is a powerful tool that not only allows
a user to expand the functionality of the software,
but it can be big a big timesaver for repetitive tasks.
Since SOFTIMAGE|XS| supports several different
scripting languages, such as Jscript, VBScript,

PerlScript, and Python, it gives the user the choice to
choose the language, which is especially convenient
for experienced programmers that can jump right
into scripting if they know one of these languages.
However, if a beginner intends to start scripting with,
for example, Python, difficulties will arise quickly, as
the documentation contains mostly only examples
of VBScript and Jscript. With limited documentation,
the user might have a hard time making progress.
This issue of HDRI Magazine tries to address this
problem a bit. Bernard Lebel will explain how to use
Python to handle passes, partitions, shaders, and
the render tree in his article “Scripted Rendering With
SOFTIMAGE|XSL."

Ed Harriss, industry veteran and XSI expert, focuses
his article on job hunting, which has become more and
more difficult, since every year so many schools train 3D
artists and output new talent that are competing for the
available jobs. Also, with the training available today,
such as videos, books, and Web tutorials, many people
are self-taught and try to break into the industry. So,
being good at 3D is only one part of the business; the
other is how well you can sell yourself. Since Ed wrote
an entire book on that topic, he can give great insight
into this area in his article.

The goal for future issues of the SOFTIMAGE|XSI
section in HORI Magazine will also be to touch topics
that haven't been covered yet in other magazines or on
the Web, and help to fill in gaps so that users can learn
about the potentials of SOFTIMAGE|XSI and experi-
ment with features they didn’t touch before.




KOOSHLINGS

y fiends call me Koosh. It

came about from a strange
series of events way back in high
school, but it's stuck ever since.
Its my pleasure to come on as
HDRI 3D's the new Maya Editor
with this, the third issue to date. If's
nice to see a publication dedicated
to bringing together the different
trains of thought under one cover,
and as we progress, | hope to help
make HORI 3D a very influential component of the professional
and academic CG landscape. If's amazing how free and open
people are to sharing their knowledge to help out students and
colleagues, and it is with this spirit of open communication and
the energy of software makers like Alias that we will all expand
and mature this exciting field. | look forward to looking forward,
and to kick off this Kooshlings Column with some of my thoughts
of the future: There is a powerful interest in CG creeping into the
mainstream, but how do we help nurture it further?

DARIUSH DERAKHSHANI
MAYA EDITOR

“3D KLEENEX"

Like the brand name Kleenex has overcome the actual
product's name (tissues) in people’s way of speaking, the term
“Photoshop” is now as much a verb as a brand name, and has
come to represent image editing for many people in the industry
and consumer market alike. This is in no small part due to the
deluge of inexpensive digital cameras and their image editing ap-
plications in the consumer marketplace. It would be rather difficult
to find a person who would not know what someone means with
the phrase | Photoshopped myself into that picture.”

So when do we see a similar treatment with 3D? At what
point would you be comfortable saying, “| Maya-ed a spaceship
into my son's birthday party video™ to your technophobic, if not
barely literate, neighbor and not get looked at as if you stepped
on his hamster?

It's safe to say that 3D sofiware has indeed gone through
a massive move into the enthusiast market. With Moore's Law
observing that CPU power roughly doubles every 18 months, a
computer on your kitchen counter is very capable of handling 3D
content creation, as well as digital video editing and compositing.
It's refreshing to see this trend create excitement for a lot of com-
puter and design enthusiasts looking for a new creative outlet for
themselves. Add to that rigorous price drops for these computers
and the 3D applications, as well as moves by some of the software
makers to create and distribute free leaming editions of their ap-
plications—such as Alias’ Maya Personal Leaming Edition—and
you have an enthusiast market that is, well, enthusiastic. This
also proliferates 3D well beyond the typical digital content creation
industries into the hands of nomal people. Well, as nomal as
people like us can get.

But what's it really going to take to get 3D software like Maya
into the consumer mindset, still one critical step from the enthusiast
mindset? Enthusiasts, to some extent similar to pros, don't mind
paying a premium for good hardware, and they'll spend the time
and money leaming the complicated applications. When do we see
a good push into the consumer market? When can the average
Joe pick up his mouse and animate a talking sandwich into digital
video of his weekend trip up to the cabin to see his other wife and
the kids no one knows about?

Certainly the technical requirements are there in even the
mid-level consumer computer, so the machines have ability, but
what about their users? Simply, there is a level of intimidation here
for them that keeps 30 out of the common market, so that we
don't cuently see 3D applications on the shelf at Best Buy. 3D

applications, for the most part, are just too complicated to leam for
the average headed-to-an-early-heart-attack Best Buy browsing
kind of guy.

Not to insinuate that Best Buy gives you heart disease or that
Photoshop is a snap to leam, but because this average person can
pick up a digital camera and transfer his images to his PC as easily
as heating up a burrito, he will eventually be faced with the option,
perhaps the delicious lure, of Photoshopping these images at
some point, allin due course. Little red eye editing here and there
and before long, you have this guy's illegitmate kids fiying through
pictures of clouds pilfered off the Intemet.

So either we need to make everyone attend an art school that
teaches 3D or come to a point where 3D applications are "point
and shoot” easy to operate, which could mean cutting out a lot of
the features. But is this a bad thing, per se? If you take a look at
the feature set behind an inexpensive image editor bundled with
a point and shoot digital camera and the full-featured Photoshop,
you will see a big difference in what you can do. This distinction can
simply be made with the line between amateur and professional.
The pro needs a set of tools fo satisfy the endlessly needy art
director who ‘just can't quite put his finger on it,” while the average
consumer will just need to fix a few image flaws and maybe cut out
an ex-boyfriend from a vacation snapshot.

With a lighter version of Maya, for example, the consumer can
be given just enough tools to model and animate a simple talking
sandwich, or dancing peppers to liven up his lunchtime DV. Per-
haps add-in modules can expand upon that capability, much like
Photoshop plug-ins, and give this person the chance to animate
particle steam from the dancing peppers, or create refiections and
full-on characters.

Whatever the exact specs, a lighter featured and therefore
easier to use 3D package is key for the basic consumer market
to enjoy 3D creation. There are a few of these offerings out now,
like Carrara Basic or Poser or Animation Master, but they have
not yet set fire to the consumer market place. Perhaps big name
recognition of a “Maya Limited Edition” would lend more credence
to a consumer movement?

In any event however, with DV and firewire becoming the norm
for most people with video cameras, consumers will eventually see
the many options, even the allure of adding animated 3D elements
to their videos as much as enthusiasts are seeing today. Giving
them an affordable and fairly featured but less complicated option
becomes perhaps the difficult onus of the software makers to
integrate creating easier CG with a typical family's captured DV
footage. Teenage Johnnie can sit down at the family PC and pound
out a CG spaceship using a simplified GUI in such an application,
keyframe it flying around in the background of their summer frip to
visit the uncle no one talks about, and tell his friends he “Maya-ed
itin there.”

The thing is, until software makers take a bigger leap of faith
into this market with such an offering, consumers will continue
to forgo 3D as a common toolset for their everyday computing.
Perhaps with the soon-to-come truly 3D-space desktops in an OS
like Windows, the consumer market will soften up more to desktop
CG; giving people more time to adjust to this new CG lexicon
and workflow may have to be the key. At some point, though, we
eventually have to see a stripped down Maya or LightWave or
SOFTIMAGE|XSI that can easily integrate CG into family videos
at a consumer software price. Of course, this assumes the task of
making such an application from the robust and deep software in
production environments now is anything less than excruciating for
a company to undertake. This point will come, and if Moore’s Law
is to apply to how deeply people use their computers as well as
their CPU speeds, then the alam is about to go off for 3D.
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STARGATE ATLANTIS RISING

=

ALL THAT IS“OLD, [S NEW AGAIN”

BY BRUCE G. WOLOSHYN & THE ATLANTIS VISUAL EFFECTS TEAM

MMPSRIG AT E
AT L2 NIEEN

copyright 2004 MGM Worldwide Television

targate Atlantis is MGM Television ‘ version of one of the genre’s most popular
and the Sci-Fi Network's new {
spin-off series, based on one of |

science fiction’s most exciting television

shows, Stargate SG-1. It follows an entire-

ly new Stargate team as they embark on a

shows. Little did | realize exactly how much
work this project was to entail.

NEW PIPELINE

First, we wouldn’t just be working on
the pilot to the new series. As a matter
of fact, to adhere to the new show's
production schedule, we would actually
be working on (and delivering) several

dangerous mission to the distant Pegasus
Galaxy, where they discover the mythical
lost city of Atlantis ... and a deadly new
enemy, the Wraith.

When | was first contacted by Rainmaker
president, Bob Scarabelli and told that we
had been awarded the visual effects for
the series pilot, “Rising,” | was elated. We
had been involved in the creation of the
visual effects for Stargate SG-1since its pilot

subsequent episodes of Stargate Atlantis,
even as we were still designing and
creating effects for the pilot. In addition,
we would still be contributing effects to
season eight of Stargate SG-1. Plus, just
to make things a little more interesting,
back in 1997, and now we would have the
opportunity to help design an entirely new

both of the shows would no longer be
shooting on film and finishing in standard

HDRE 3D 1SSUE3
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TOP, THE LOST CITY OF ATLANTIS
LOWER LEFT, OPENING TITLE CARD
LOWER RIGHT, PUDDLE JUMPER IN FLIGHT

definition as we had for the previous
seven seasons on 5G-1. Both Stargate SG-
I and Stargate Atlantis would be making
the jump to high definition video acquisi-
tion and finish in full 2Z4p HDTV.

This new acquisition and delivery
standard was one of the first challenges
that we would have to incorporate into
our new production pipeline for the
show. From the visual effects standpoint,
this would lead to a list of concerns
regarding infrastructure,
grades, staffing, rendering, and delivery
schedules. Clearly, the high definition

system up-



hurdle would be one of the first things
we would have to clear in preparing to
start work on the show.

For both Stargate Atlantis and Stargate
SG-1, the answer would lie in producing
the visual effects in a combination of full
HD, as well as SD. We would then up-
convert the finished SD effects back to
HD for insertion into the HD-assembled
show. Fortunately, digital developments at
Rainmaker have made this a seamless in-
tegration, as the SD visual effects maintain
rigid adherence to the progressive video
format. That is to say, the visual effects are
all executed at 24 progressive frames per
second, even though the spatial resolution
is standard definition.

For season eight of Stargate SG-1and the
inaugural season of Stargate Atlantis, this HD-
SD-HD visual effects pipeline has proven to be
a robust performer, with the final HD tape
proceeding fluidly into and out of the VFX

shots. In a perfect world model, of course,
everyone would prefer all of the visual effects
to be native HD resolution. However, with the
size, scope, and schedule of the visual effects
on both series, the transcoded SD-HD hybrids
are proving to be the best of both worlds.

( PREVISUALIZATION )

With the Stargate Atlantis pilot's schedule
overlapping so many other episodes of both
series, the efficiency of shot-by-shot execution
was always at the forefront of our planning.
To this end, we utilized previsualization to a
much greater extent than we had ever done
before on SG-1. In many cases, our final shots
matched second-for-second to the previs that
was approved before the cut of the pilot was
even locked.

This production model not only helped
us to lock a significant amount of visual
effects shots before editorial locked the
cut of a particular scene, but sometimes

even before we went to camera. Complet-
ing previs prior to going to camera then
allowed us to further refine our elements
list so that we knew exactly what we were
shooting on the day. In this way, many
times our artists were following an already
producer-approved template, focusing on
the art of their discipline, rather than wast-
ing time working out the blocking.

There is no better example of this
process than the climactic space battle
at the end of the show. The sequence
consisted of over 30 shots, all of which
had only brief descriptions of the action
in the script. In order to better work with
the producers and director in choreo-
graphing the battle, we set up an on-site
animation station. This physical proximity
to production allowed us to be able to
receive quick feedback and implement
changes much faster. Because the shots
were prevised in LightWave, we were

able to come back to Rainmaker, while

copyright 2004 MGM Worldwide Television
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STARGATE ATLANTIS, RISING
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ATLANTIS PIERS BREACH THE SEA SURFACE

ATLANTIS CENTRAL TOWER WITH MAYA PARTICLE ANIMATION

the animation was still being created,
and substitute the previs models with
the high-resolution ships that were being
built. Animation and camera movement
could be approved with the low-resolu-
tion models and then sent back to have
the real ships substituted in their place.
This provided a seamless integration
from previs to final renders that allowed
us to get the high volume of shots in a
very short timeframe.

)

One of things that [ think is kind of
sad in today’'s world of visual effects is
that everyone thinks, “They just did that
with a computer.” In the world of both
SG-1and Atlantis, this couldn’t be further
from the truth. As a matter of fact, the

QAORE THAN JUST CG

elements shoot for the Atlantis pilot was
the most comprehensive elements shoot
ever for Stargate.

:l? HDRE 3D I1SSLE 3
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For instance, even though we were
creating literally hundreds of passes of
particles in Maya for the sequence where
the city of Atlantis rises up to the surface
of the ocean, we also knew that nothing
looks more like water, than ... well ... real
water. To facilitate some of the huge scale
water effects we needed as the city's
massive pier decks breeched the surface,
we turned to Wray Douglas and the
special effects department. Working to
a scale drawing of the LightWave model
of Atlantis's pier E, the special effects
department created a large-scale model
of the pier out of industrial-strength steel.
This black box model, over seven meters
in length and weighing in at a little over
two tonnes, would represent the virtual
625 meter pier as it broke the surface of
the ocean. The massive steel model was
then hauled to Vancouver's False Creek,
and repeatedly dropped into and lifted
from the water by a huge construction
crane, Filmed at 120 frames per second

g S
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ATLANTIS CENTRAL TOWER BREAKS THE SURFACE
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AS THE CAMERA BREAKS THE OCEAN SURFACE

from a variety of angles, this large-scale
model provided us with a wealth of real
world water elements to composite into
city rising sequence.

To create the Wraith Phantoms, a
hallucination projected by the Wraith
creatures, we needed a quick and dirty
technique that would give us lots of
coverage and angles that we could not
only use on the pilot, but also re-use
for future yet-to-be-written episodes.
To do this, the wardrobe department
made us a costume of streamers in
black, white and blue. We then shot on a
bluescreen stage, so that wherever there
was blue fabric on the Phantom it would
be transparent. Adding fans blowing at
the actor, the streamers would blow up
into the air. Taking that footage into the
Inferno workstation and averaging it,
prior to compositing, gave the creature
the ghostly feeling the producers were
looking for.
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PUDDLE JUMPER BAY INITIAL DESIGN MODEL

Finally, elements
shooting, we shot for a day in the park-
ing lot at the studio. Our shot list for
this day included a lot of scene-specific
elements that we would need, based on
the design work that we had already
completed in the digital realm. Once
again, stressing that actual photography

to complete our

of elements would assist us just as much
as our digitally created ones. Filming at
a variety of frame rates, we shot water
being splashed onto a sheet of glass
for the shot where the camera breaks
the surface of the water. We also shot
a great many plates of general water
splashing down the sides of black box
surfaces. These would then be used as
texture maps on the LightWave model to
help make our city look wet. Of course,
as with all of our other elements, we
would multi-pass render a variety of
“wet look” texture maps for maximum
control by our compositing team.

(MODELING. LOTS OF MODELING j

The one thing that really differentiated
the Atlantis pilot, “Rising,” from working
on S5G-1, was the sheer amount of 3D
modeling that had to be done. Every
single model we needed, from the digital
props and set pieces, to the spacecraft
and city itself, had to be modeled from
scratch. There would be no library of
past seasons to draw on for this show.

“Rising” begins as we see an alien
spacecraft, called a Puddle Jumper, flying
over Antarctica towards the lost city. The
flight path was carefully planned, but
covered an immense area. Detail in the
icy plain was built up in the 3D model
so that we only saw exactly what was in
the camera view; zones of priority were
set depending on how close the camera
would actually get to any given feature.
The snow and ice surface used a great

| many procedural textures since they

copyright 2004 MGM

ATLANTIS/OPENING SHOT

copyright 2004 MGM Worldwide Television

PUDDLE JUMPER BAY FINAL COLOR RENDER

work well on a micro and macro scale.
Maya fluids were also utilized in the
opening sequence to push a wall of snow
and ice towards the camera as Atlantis
leaves Antarctica.

The Puddle Jumper itself was first built
as a practical set piece that we would
then replicate in CG. At first glance, the
Puddle Jumper seems like a very simple
cylinder, but with all the complex curves
built into the paneling, it proved a little
more challenging to recreate. We took
digital photographs of the practical set
piece that we used for texture maps. We
then removed as much lens distortion
and irregular lighting as we could, and
stitched together the top, front, back,
and side angle views. We then took those
assembled templates, stretched them to
conform to our on-set measurements,
and ended up with photo-real blueprints
from which we could build the Puddle
Jumper. This made the texturing phase
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SPACE BATTLE EXPLODING DART PREVISUALIZATION

of the model a snap, because everything
lined up perfectly.

Due to the hectic shooting schedule,
we actually had only about a 15-minute
window on-set to photograph the inte-
rior of the practical Puddle jJumper cock-
pit. However, from these photographs,
our digital interior modeling ended up
being fairly simple, and there wasn’t
really a whole lot of geometry needed,
because the photographs that we used
as texture maps were so good. In some
cases, we can actually move the camera
right up to a dial on the main console
and everything still looks great. We later
took photographs of the actors, mapped
them onto flat planes, and dropped them
inside the cockpit model. A very simple
trick, but we had some people scratch-
ing their heads trying to figure out how
we got those guys in there. Then, after
getting the majority of the 3D model to
exactly match the practical set piece; the

Pl
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engines and their respective compart-
ments, missile bays, and the underside
of the Puddle Jumper; were designed
and modeled in LightWave to match the
style of the rest of the ship.

We followed a similar modeling
scheme for many of the CG models
that had to match existing set pieces,
including the Atlantis Stargate; taking
photographs and stretching them to fit
our measurements, which we then used
as modeling templates.

As well as creating props and ships,
we were also faced with creating sev-
eral digital set extensions and virtual
environments. The Puddle Jumper bay,
located in the central tower of the city,
is a good example. The Puddle Jumper
bay is basically a parking garage and
maintenance facility for up to twelve
Puddle Jumpers, located directly above
the city’s main gate room. The starting

COMPLETED LIGHTWAVE EXPLODING DART FIGHTER

PRy . copyright 2004 MGM Worldwide Television
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point for this was the practical set piece
at the studio. What was practically built
represented the rear of one of the six
bays on the main floor of the two-story
structure. Texture photographs were
taken of all of the on-set walls. These
photographs were later digitally painted
into more variations for the many more
digital walls. While still at the studio, we
then trekked over to the main Gaterium
set, and in between the live action takes,
we took additional photographs. These
would provide additional textures and
act as reference for the architectural
style favored by the ancient builders of
Atlantis. This was to prove very impor-
tant, as we constantly strived to make
the digital sets look like they belonged
with all of the live action sets.

Lighting the bay was done with 200
lights of all types: shadow mapped spots,
point lights, and area lights. To make
rendering more efficient, some smaller




light sources were baked onto the actual
textures. A few radiosity test renders
were done to get a feel for the look
This
reproduced using regular lighting to,

we were after. look was then
once again, keep our rendering times
reasonable. Getting shots out fast meant
building only the sections visible in the
first shots, then finishing off the rest of
the bay as time permitted.

The centerpiece for the pilot's model-
ing was, of course, the exterior of the
lost city itself. The exterior Atlantis
model went through many design itera-
tions, and by the time it was completed,
it came in at around four million poly-
gons and over a gigabyte of textures.
Because of its size and the variety of
shots present in the pilot, it needed to
look good from all angles; hence, it was
an extremely complex model. In lighting
the city, we created a lighting rig with
a combination of directional and area
lights that could be adapted to unique
situations, but which allowed us to keep
consistency through all of the shots, not
to mention show off all the work that had
been done by the modeling team on this
monster model.

( DIGITAL WATER )

Although we had a massive list of mod-
els that needed to be created for the pilot,
none was more daunting than the model-
ing of the surface of the sea surrounding
the city of Atlantis. We struggled at first
whether to go with Maya, because of its
inherent water controls, or LightWave, as
that's what we would be creating the city
and all of the master scene files with. In
the end, we ended up going with both.
The main water surface was created in
LightWave and utilized the NaturefX
plug-in from Dynamic Realities to help
finesse the look. We then used Maya for
the hundreds of layers of particles and
splash dynamic simulations.

(ary risiNG g

In the city rising sequence, we had
to push this four million-polygon model

through the ocean surface and get a
convincing “breaching” of the water.
This meant developing a pipeline to get
scenes back and forth from LightWave
to Maya, as LightWave was used for
the rendering of all primary elements
(water, city and sky), while Maya was
used for particles and splash dynamic
simulations. Simulation was also used
in LightWave to get the water to bulge
and push out as the buildings passed
through the surface.

In order to give the illusion of water
dripping and falling down the sides of
the buildings in the rising sequence, we
did a great deal of multi-pass rendering
to provide our compositing team with
many layers of the buildings to achieve
the proper look. RGB, z-depth, specular,
and shading passes for the city, as well
as various water falling elements that
were both used from our elements shoot
and textured onto the buildings, as well
as custom procedurals.

( SPACE BATTLE )

Our theory with respect to lighting the
space battle sequence is similar to how
we like to design spacecraft. That is, to al-
ways try to make the ships look cool from
any angle, even if you have to sacrifice a
little bit of realism. Unfortunately, if you
have to light a planet from one angle and
then you do a reverse of that shot in the
very next cut, the lighting has to match.
But we try to cheat as much as possible
if it's going to make a shot look better or
more dynamic. Generally, wherever you
go in 3D space, strong backlighting can
help heighten the dramatic effect. Blue or
orange fill always looks great, especially
with the evil Wraith Dart fighters. Also, if
ever there is a question about where that
light source came from, thank goodness
for the off-camera stars that wander
through space.

One of the many technical challenges
we faced in the Atlantis pilot was get-
ting the Wraith Dart ailerons to rotate
automatically based on the attitude of
the Dart. The goal was to eliminate the

need to hand-animate the ailerons, so
the artist need only turn and bank the
ship. Of course, anyone who has ob-
served aircraft knows that ailerons will
move before the craft begins to turn,
so we needed a way to anticipate what
the craft was going to do before it hap-
pened, and feed that information to the
aileron rotation nodes.

This was done first by adding a null
object to the Dart. This object (which is
unseen in the shot) simply records the
motion path and rotation values of the
Dart. Using mathematical expressions,
we were able to look at the orientation
of that Null object at any time in the shot.
We would then take the Null's orientation
at the time (NOW), and compared it with
the Null's orientation at the future time
(30 frames from NOW), taking the dif-
ference between the two as the rotation
value that was applied to the ailerons.
One aileron was given this as a positive
value, and one as a negative value, since
the ailerons rotate opposite each other in
order to make the craft bank. We also had
to apply rotation limits to the ailerons,
otherwise they would just spin around
and around if the craft performed a barrel
roll. Once the expression and limits were
applied, we had a craft whose ailerons
would rotate automatically in anticipation
of an upcoming turn.

We also wanted the Darts to explode
more dramatically than just being cov-
ered by a single ‘poof’ explosion. To that
end, we created a “scored” stunt Dart,
much the same way that productions
have stunt cars. The hull of the stunt
Dart was given three-dimensional thick-
ness and divided up into a couple dozen
areas, which were in turn broken into
tiny pieces. All or part of any given area
could be blown apart in large chunks or
tiny pieces with independent explosion
simulation timing and magnitude for
each given area. This allowed us to start
(and end) a Dart’s destruction based on
where it was actually hit by blasts and
to make the Dart's annihilation last to fit
any given shot.
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(PEOPLE MAKE PICTURES )

we have
just completed the final shot on the
last episode of season one of Stargate
Atlantis. | find it hard to write about this
newest incarnation of the series without

As | write these words,

feeling a profound sense of pride about
what our team has accomplished. I've
always felt very strongly about stressing
that although we live in an age where
incredible advancements in technology
have allowed us unprecedented control
in the images we create, that it is the
“people” that create these images, not
the technology. This year, the first of
our new journey to Atlantis and the
Pegasus Galaxy, | have been honored
to work with some of the finest artists
and technicians | have ever known. Ev-
eryone made sacrifices to deal with the
almost impossible schedule, everyone
brought all the techniques they knew
to the table, and most of all... everyone
cared. To each one of them, | extend my
sincere thanks for a job well done. No,
superbly done.

I'd also like to thank our executive
producers, Brad Wright and Robert C.
Cooper, for entrusting us with their
world and the characters that inhabit it.
In a year that has seen two such huge
visual effects projects on the go simul-
taneously, and particularly the pilot to
Stargate Atlantis, their guidance and
support, and that of visual effects
producer Michelle Comens and director
Martin Wood, has made an immeasur-

able difference.

With Stargate Atlantis premiering
on the Sci-Fi Network to more than 4.2
million viewers, “Rising” earned a 3.2
Nielsen rating. This set a new ratings
record on the Sci-Fi Network, and should
help to keep us busy exploring the Pega-
sus Galaxy for some time to come. g
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R

Visual Effects Producer
Visual Effects Supervisor

Michelle Comens
John Gajdecki
Bob Scarabelli

Rainmaker Visual Effects Executive Producer

Bruce G. Woloshyn Digital Effects Supervisor &

Lead Digital Compositing Artist

Visual Effects Co-ordinator
Tara Conley Visual Effects Co-ordinator
James Rorick Visual Effects Co-ordinator
Janice Groom Visual Effects Operations Supervisor

Jinnie Pak

Dan Mayer Lead 3D Animator
Wes Sargent Lead 3D Animator
Rod Bland 3D Animator
Jose Burgos 3D Animator
Nicholas Boughen 3D Animator
Tom Brydon 3D Animator
Craig Calvert 3D Animator
Ho Sung Cheon 3D Animator
Bryan Davies 3D Animator
Tristam Gieni 3D Animator
Trevor Harder 3D Modeller
Sean King 3D Animator
Megan Majewski 3D Animator
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Debora Dunphy
Simon Ager
Jordan Benwick
Kristy Dearholt
Chris Doll
Keegan Douglas
Peter Hunt
Mathew Krentz
Colin Liggett
Tannis Mathers
Christine Petrov
Lee Pierce
Carmen Pollard
Gary Poole
Trevor Strand
Chris Wren

Tracey Baxter
Madhava Reddy
Amnold Yuki

Hamish Hamilton

Ken Hayward
Ronald Knol
Zane Harker

Director of Technical Development
VFX & IT Engineering Supervisor

Lead Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist
Digital Compositing Artist

Concept Artist

Rotoscope Artist
Rotoscope Artist
Rotoscope Artist

Visual Effects Assistant

Resource Manager

Krista McLean 3D Animator  Joe De Michelis Information Systems Administrator

Daniel Osaki 3D Animator  Chi Pham VFX Systems Administrator

Mark Pullyblank 3D Animator  Grant Bowen Applications Support Specialist
Les Quinn 3D Animator
Vishal Anand 3D Animator
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SUPERVISOR AT RAINMAKER

Bob Scarabelli FOR BOTH  STARGATE
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Rainmaker Founder,
Mentor and Friend

A man whose character and
vision will always inspire me.

ATLANTIS AND STARGATE
SG-1. HE HAS BEEN WITH
THE STARGATE FRANCHISES

' FROM THE VERY BEGINNING,

STARTING WITH THE PILOT
OF STARGATE SG-1 BACK IN

1997 AND HAS BEEN HONORED WITH FOUR EMMY
NOMINATIONS FOR HIS OUTSTANDING WORK
AS LEAD DIGITAL COMPOSITING ARTIST ON THE
SHOW. BRUCE'S OTHER VISUAL EFFECTS TELEVI-
SION CREDITS INCLUDE GENE RODDENBERRY'S
ANDROMEDA, HIGHLANDER, JAMES CAMERON'S
DARK ANGEL, MILLENNIUM, AND THE PILOT
TO SMALLVILLE. HIS FEATURE FILM CREDITS
INCLUDE SUCH TITLES AS ANTITRUST, MISSION
TO MARS, AND 3000 MILES TO GRACELAND.
BRUCE AND HIS VERY SUPPORTIVE WIFE
RAMONA MAKE THEIR HOME BY THE SEA IN
SUNNY SOUTH SURREY, BRITISH COLUMBIA,
WITH THEIR TWO WONDERFUL SONS.
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BY NICHOLAS BOUGHEN

is article deals only with the
relatively small subject of lighting
and shading in Sasquatch. This
means most of the tools in Sasquatch won't
be dealt with. This is just fair warning—if
you're having trouble with fur density,
length, kink, frizz, curl, combing, or any of
the other zillion parameters, you'll have to
find the answers elsewhere.

| commonly read and hear of LightWave
artists having difficulty getting Sasquatch
to look good and behave predictably
under lighting. We all know what happens
when we turn on a light, aim it at a model,
and set the color and intensity, but once
we add Sasquatch fur, the results can be
unexpected if we aren't careful.

The main reason things don’t always
work out as expected is twofold.

First, Mr. Worley, author of Sasquatch,
painstakingly provided us with many tools for
shading the fur and hair fibers. This awesome
power, however, is a double-edged sword. It
means we have great control over how the fur
fibers look, but it also means we need to know
exactly how to drive all the controls. We also
need to know how each tool interacts with
its neighbors. It's like the difference between
a 1930 biplane’s control panel and that of a
jumbo jet. You can do a lot more with a jumbo
jet—you can definitely fiy higher and go
farther and faster, but if you're not intimately
familiar with the controls, you're probably go-
ing to crash, if in fact you manage to get off
the ground at all. Sasquatch is much like this.

HDRI 3D 1SsUE3

to exactly what those default settings should
be. The default settings, while very helpful to
get started, can be detrimental once you get

It provides you with vast power, but you'll " into more advanced lighting.
do your best if you learn exactly how the
switches and dials realty work. Note: If you are not already familiar with

| Sasquatch, two plug-ins are required to get

Second, Mr. Worley has attempted to it to render. First, make sure you have the

make our jobs easier by providing default object selected to which you want to add

settings. Rumor has it there was great debate fur or fibers. Now, on the object deforma-
during the beta testing phase of Sasquatchas | tion tab, add the Sasquatch plug-in.

MD_MetaPhig
MD_MetaPlug_Morph
MD_Plug

MD_Scan

| Geomelyy | Defom \_Re :ﬁoﬁ;wﬁrem
Morph Amourd  Metatorm_Target(FASTER)

Morph_Gizmo_Render
Morph Targe? NFX2_Ocean
| | Morph Surfaces NomalDisplacement
Poke
Relativity_Morph

SE_Displace

Distarce  SG_Explosion?

| Add Displacement
i

Sasquelch

ADD THE SASQUATCH DISPLACEMENT FROM THE OBJECTS>PROPERTIES>ADD DISPLACEMENT DROPDOWN
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Then, in the Image Processing panel, add Sasquatch in the Pixel The other is on the Rendering and Shadowing panels of the
Filter dropdown. pixel filter.
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ADD THE SASQUATCH PIXEL FILTER IN THE
EFFECTS>PROCESSING>ADD PIXEL FILTER DROPDOWN

This article is split into two sections. “The Essentials” covers
things you really need to know to get good looking lighting and
shading out of Sasquatch. “The Extras” covers additional tools that
can help you further. If you're a serious fur and hair artist, you'll A :
want to know everything here. If you're in a hurry, just read ‘The : el e R TR
Essentials” and cover the rest when you have time. Enable Cast Shadows|__

[Rendering | [ Wind__|

Receive LightvWave Shadows| |
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So we're dealing only with lighting and shading in Sasquatch e R e S
today. This takes place in two panels. One is the Deformation et el s :‘rj:
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THE SASQUATCH PIXEL FILTER SHADOWING TAB

e ki ' : — e Let’s deal with the Sasquatch settings one at a time. To begin
. — == with, on the Deformation plug-in's Shading Panel, we have our old
THE SAGUATGH SHADING 1B familiar Diffuse, Specularity, and Glossiness.
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LIGHTING SASOUATCH

Just as with any LightWave texture, the Diffuse value determines
how much illumination a texture (or in this case, a fiber) receives from a
light. For example, if a light is set at 100% and the Diffuse value is set at
50%, then the fiber will receive (or, technically, reflect) 50% of the light.

FUR DIFFUSE VALUES CHANGE THE BRIGHTNESS OF THE FUR FIBERS

All fur settings are default, except Diffuse, as noted in the
illustration. Note that the ball texture does not change when the
Diffuse value of the fur is changed, as fur settings are completely
independent of the geometry’s texture settings.

The Specularity parameter controls the brightness of the specular
highlight, and the Glossiness parameter controls how shiny (or
small) the specular highlight is. Materials that are very smooth will
have a much smaller specular highlight.

NOTE: It is important to note that, while Specularity and Glossiness
controls work the same way they do in LightWave, the actual specular
highlights are not the same. Because each hair fiber is essentially a long
tube, the specular highlights are stretched along the length of the fiber.

This is where we leave the familiar world of LightWave parameters
and delve into unique Sasquatch settings.

Normally, the specular highlight will be the color of the light that is

Specular Tinting
100% 0%

SPECULAR TINTING ADDS FUR COLOR TO THE SPECULAR HIGHLIGHT

creating the highlight. But Specular Tinting is a great tool that allows
you to let some of the fiber color into that specular highlight. If, for
example, you have a calico cat, then some of the orange will bleed
into specular highlights on that part of the fur, while specular high-
lights on the white fur will remain white. Specular Tinting will tend to
make the specular highlights subtler and less visible, since they blend
in with the color of the material instead of being a white highlight on
top of it, but the highlights will also behave more realistically.

The settings on these two images are identical except for specular
tinting. With Specular Tinting at 100%, the specular highlight strongly
takes on the color of the fiber. This actually makes the specular
highlight difficult to see. With Specular Tinting set to 0%, none of the
fiber color comes through in the highlight, and the highlight color is
determined entirely by the color of the light source. The best looking
and most visible specular highlight will probably be somewhere in
between 0% and 100%, where the highlight is easily visible, but also
takes on some of the color from the fiber.

Translucent Lighting and Direct Lighting fall into the category of
“Beyond Here There Be Dragons.” It's very easy to get in trouble by
using these two values to set up your lighting. If you find you have
to move the object or the light, suddenly the fur lighting behaves

differently and you have to relight the shot.
| strongly recommend beginners to follow these three steps:

In your pixel filter, make sure you have “Receive LightWave

Shadows” turned on. This will ensure that light will not pass
through your geometry and light the fur on the far side (this is the
single highest cause of consternation among new Sasquatchers).
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Receive LightWave Shadows
On

Off

WHEN THE FUR RECEIVES LIGHTWAVE SHADOWS ANY LIGHTWAVE
GEOMETRY BLOCKS THE LIGHT RAYS

Both these images have a spotlight source above and to the
left, except the left image appears to have an additional light
source below and to the right, because otherwise, the bottom
right area of the fur would be in shadow. However, Sasquatch
is not receiving LightWave's shadows, so Sasquatch doesn’t cut
out the light that would normally be stopped by the geometry of
the ball. In the right image, Sasquatch “sees” that the geometry
is casting a shadow, so the bottom-right part of the ball is in
shadow, just as it should be.

If you haven't turned on “Receive LightWave Shadows,” then
start with a Translucent Lighting value of 0%.

TRANSLUCENT LIGHTING SET TO 0% ON THE SHADING TAB

This will ensure that your initial lighting is working just as
you'd expect it to. You'll see light on the correct side, just as
it should be. Note: If you're already using “Receive LightWave
Shadows,” then you'll notice that Translucent Lighting tends to
brighten and soften the look of the fibers. This is a powerful and
subtle effect, making the fibers appear translucent, just as they
often do in real life.

Always use spotlights with Shadow Maps if you can.

Sasquatch calculates its own shadow maps. This will save
you huge render time. Don't use ray-traced shadows if you can
avoid it.

LIGHTWAVE TUTORIAL

TRANSLUCENT LIGHTING VS. DIRECT LIGHTING

Direct Lighting works much the same as any lights in Light-
Wave work on any geometry texture. Light is shone directly
onto a texture and the texture is illuminated by it based on
lighting intensity, angle, color, etc. With Translucent Lighting,
the fiber seems to be given an almost luminous quality. The
huge advantage to this is that, since fibers are thin lines, Direct
Lighting doesn’t do a good job on fibers that are pointing
directly at the light source, because there is so little surface
area, but Translucent Lighting will illuminate the fiber no matter
which direction it is facing (provided it's not in shadow).

I always start with only Direct Lighting, and then add Translucent
Lighting to fill and enhance.

Next on the list is “Ambient Strength.”

Ty 700% mg
| M-] 0% :_n E_]}

AMBIENT STRENGTH IS SET TO 50% ON THE SHADING TAB

This setting lets you determine how much of LightWave's
ambient light will affect the fur fibers. If, for example, you have
your Ambient at the LightWave default of 5%, but you don't
want any ambient light on the fur, then you can set this to 0%
to cut it out entirely. If, on the other hand, you want a high
ambient light, without changing LightWave's settings, then
you can set this value to 1000% to set the fur's ambient light
intensity to 50%. LightWave's ambient parameter is multiplied
by the Ambient Strength value to determine how much ambient
light is received by the fur fibers.
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LIGHTING SASOUATCH

Self Shadowing: This setting determines the shadow density of
the shadows cast by the fur fibers onto other fur fibers

In order to use Self Shadowing, first you must turn on the Self Shad-
owing button in the Shadowing panel of the Sasquatch pixel filter.

0K ERSRery e L]

THE “SELF SHADOW" SETTING LETS YOU DETERMINE THE OPACITY OF THE
SHADOWS FROM ONE FUR FIBER TO ANOTHER. HIGHER VALUES MAKE
DARKER SHADOWS

] [Shadowing ] (__8p

wva Sh: |b

Self Shadowing

ad

WITH “SELF SHADOWING" ON, FUR WILL CAST SHADOWS ONTO OTHER FUR F!BERS)

The default setting is 70%. At the top right of this page are some
different Self Shadowing settings.

If you wish to have your fur or hair fibers cast shadows onto other
fibers or onto your geometry ... say you have very bushy eyebrows
over the eyes ... then you'd want to turn on “Enable Cast Shadows"
in the pixel filter. You also need to add a texture shader to your
geometry called “The Shadow of Sasquatch.”

:lilﬂ HDRI 3D 1SSUE3

Self Shadowing

hilghts mm
¥ 100.0% [o][a]
10.0% mm

“THE SHADOW OF SASQUATCH" IS A SURFACE SHADER THAT
ALLOWS GEOMETRY TO RECEIVE SHADOWS FROM SASQUATCH

The shader controls are fairly straightforward and are well
covered in the Sas manual. Note: Remember that in order to cast
fur shadows onto geometry, you must have Enable Cast Shadows
turned on in the Sasquatch pixel filter.

Summing up, we want to ensure the following things:

+» We are using spotlights with shadow maps

+ We have Receive LightWave Shadows and Self Shadowing tumed ON in the pixel filter.
+ We start with a low Translucent Lighting setting, and then turn it up as needed.
+ We are aware of how much ambient lighting we are receiving from LightWave.

+ We are aware of how much “Self Shadowing” we are using on the fur fibers.




LIGHTWAVE TUTORIAL
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ENABLE CAST SHADOWS TURNED ON IN THE SASQUATCH PIXEL FILTER
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Now that we have the lighting control basics down, we can set T A T .|
up a simple four-point rig, and see how our settings work. PR R o D‘\;
self-Shadow Softness [

Here are my final rig, settings, and render. You'll notice there’s
nothing special about the lighting rig at all. It's a very basic light-
ing rig, just as you'd use on any object. All that makes the fur Sl ll-l Wit Bleanm
look nice is a good understanding and skillful application of the

shading settings Remaining 4+ Light Str ||||>|r 100 U% ]m|

A SIMPLE FOUR-POINT LIGHT RIG ‘ MY RENDER WITH THE ABOVE SETTINGS
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LIGHTING SASOUATCH

IN THE PIXEL FILTER, SHADOWING TAB

It's a small panel, but it holds serious control. We've already
covered the first three toggles in the panel in the Essentials section,
so let's move on.

CAST SHADOWS FROM

Cast ShadoﬁéxF

f ’T-l!I (r

CHOOSING WHICH SPOTLIGHTS TO CAST SHADOWS FROM...

If you have Self Shadowing or Enable Cast Shadows turned
on, you can force Sasquatch to select which lights it will cast
shadows from. This defaults to All Spotlights, or you can switch
to LW Shadow Spots, which means that shadows will be cast
from all spotlights with shadow maps. You can also switch it to
Spotlight List, which means you can pick only the spotlights you
want from the list “Shadow Spotlights” is found just below this
control. See image at right, top.

Sasquatch fibers will now receive shadows only from lights in the
Shadow Spotlights list.

SHADOW MAP RESOLUTION

Sasquatch calculates its own shadow maps independently of
LightWave's shadow maps, so naturally the shadow map reso-
lution can be set independently as well. This is a good feature,
since you'll often need a higher resolution for fur fibers than
you will for geometry, since the fibers are so small and narrow.
See image right, bottom.
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Lightvave Order

THIS IS THE LIST WHERE YOU SELECT WHICH
SPOTLIGHTS TO CAST SHADOWS FROM

SASQUATCH SHADOW MAP RESOLUTION IS INDEPENDENT
OF LIGHTWAVE'S SETTINGS

USE LW'S SHADOW MAP ANGLES

If you are using something other than the cone angle for
your spotlight's shadow map, toggling this switch will cause
Sasquatch to calculate its shadow maps at the correct angle.




SELF-SHADOW SOFTNESS

Self-Shadow Softness is a great way to simulate shadow softness
without having to go to the trouble of using expensive soft lighting
solutions like area lights or even spotlight arrays. I've found myself
using a setting of around 50% often.

v

Self Shadowing

V|
o[ |

scolution T LY ]

SELF SHADOW SOFTNESS IS A GREAT WAY TO SIMULATE SOFT
SHADOWS SUCH AS THOSE FROM AREA LIGHTS

IF YOU USE G2, YOU CAN USE THIS TO SET SHADOW SOFTNESS ON G2 SURFACES

LIEBHTWAVE TUTORIAL
G2-SURFACE SHADOW SOFTNESS

IF you have turned on Enable Cast Shadows AND IF you are
using G2 on your surfaces, AND IF you are casting fiber shadows
onto your geometry, then this tool plugs directly into the G2
surface shader to control the softness of shadows cast from fur
fibers onto geometry. That's a lot of “IF"s, but if it speeds up your
process, hey, who can complain?

SPECIAL LIGHTS AND SPECIAL LIGHT STRENGTH

0w Softness ULLUES I
w Softhess LIRS I
Special Lights| __2: Light (1), Lioht 3) |
Special Light Strength =~ 2010 (]
Remaining 2/4 Light Strength (0L (o]

WITH THE "SPECIAL LIGHTS" LIST, YOU CAN SELECT
ANUMBER OF LIGHTS TO BE “SPECIAL LIGHTS"

This is a really cool and powerful feature of Sasquatch light-
ing. With the “Special Lights” list, you can select a number of
lights to be “special lights.” You can then independently control
those lights’ intensity but only on the fur! So a light can be
one intensity on the geometry and another intensity on the
fur fibers. “So What?" you say. Well, if you've carefully and
painstakingly textured your geometry, and then painstakingly
and carefully created your fur settings, but they now don'’t light
the same, this will help solve the problem

It will also allow you to eliminate certain lights from illuminat-
ing the fur. If you have perfect lighting in your scene, but just
one light is causing you problems on the fur, you can make it a
special light and set its special light strength to 0%.
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LIGHTING SASOUATCH

REMAINING N/N LIGHT STRENGTH

Just below the special light strength is Remaining 2/4 Light
Strength; this means, any lights that were not included in the
“Special Lights” list are considered to be “Remaining Lights.” So
you can also globally set the light intensity of the “Remaining”
lights without affecting the “Special” lights.

I once had an array of spotlights to simulate an area light
(so | could use shadow maps), and | had one set of lights for
the fur and another set for the geometry. | made the geometry
lights “Special” and set their intensity to 0%, and in the Geom-
etry’s Object properties panel, | excluded all the fur lights. In
this way, | was able to set up two identical arrays of spotlights
so that | could control the geometry lighting separately from
the fur lighting.

This is just one of many ways to use these tools. As you
become more familiar with them, you will certainly discover
new and unique uses for them too.

Most importantly of all, remember that an experienced Sasquatch
artist uses the abbreviation “Sas” instead of “Sasquatch” in casual

CG conversation, ie: "Yeah, I'm gonna use Sas on that project.”

Happy Sassing. &

NICHOLAS BOUGHEN IS AN EMMY AND GEMINI-
NOMINATED VISUAL EFFECTS ARTIST LIVING
ON THE BEAUTIFUL CANADIAN WEST COAST IN
VANCOUVER, BRITISH COLUMBIA. HE ENJOYS A
CAREER AS SENIOR VISUAL EFFECTS ARTIST
AT RAINMAKER, WORKING IN FEATURE FILMS,
TELEVISION, AND COMMERCIALS. BOUGHEN

Y

HAS TRAVELED FAR AND WIDE TEACHING

LIGHTING TO LIGHTWAVE ARTISTS AS FAR

SOUTH AS MEXICO CITY AND AS FAR EAST AS
ORLANDO, FLORIDA, WHERE HE RECENTLY PROVIDED SEMINARS TO
STUDENTS AT THE D.A.V.E. SCHOOL WHO WERE WORKING ON THEIR
LATEST CLASS PROJECT, BATMAN: NEW TIMES. BOUGHEN IS THE
AUTHOR OF THE BESTSELLING LIGHTWAVE BOOK LIGHTWAVE 3D 8
LIGHTING, AND CONTRIBUTING AUTHOR ON LIGHTWAVE 3D 8: 1001 TIPS
& TRICKS, BOTH PUBLISHED BY WORDWARE PUBLISHING.
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Make plans NOW to attend the Midwest’s

LARGEST show focusing exclusively on
NewTek’s VVT[4] and LightWave 3D!

Sfiﬂ the newest VT[4] and LightWave 3D features
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from tutorials to plug-ins and everything in between

L68IN Lightwave 3D with WaveGuide LIVE! From
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BY _JASON CLARK

ransferring CAD

Models

to DCC Applications

or many of us, the models we render
F don’t actually come from our native

application of choice; they come
from our client. Many advertisements
are made from digital models of actual
products that exist solely in engineering
software (CAD software). When dealing
with CAD models rather than polygonal
models derived from DCC applications, we
are faced with a few issues that strongly
affect the outcome of our renderings.

CAD VERSUS DCC MODELING NS

In the most basic of terms, there are two
differences between what a CAD software
user and a DCC software user will model:
level of detail and geometry.

LEVEL OF DETAIL I

Designers deal with details down to the tiny
chamfers on an edge. When modeling in CAD
software, designers are responsible for mod-
eling any detail that may be manufactured,
even more so when models are numerically
control machined (CNC machining). On the

other hand, a DCC artist will model what they
see (typically from a camera’s perspective)
and what they require to make something
look good or translate artistic intent. There-
fore, modeling seal grooves inside an engine
may not make sense for a DCC artist, but for
a designer it's a required detail. When dealing
with CAD models, you will find that because
the models are heavily detailed, they will be
extremely dense in a meshed format if not
dealt with correctly. For example, it is quite
typical to put a radius on sharp edges, and
because this size of feature is small in com-
parison to the surrounding geometry, you
will find that it is polygon intensive to retain
such features.

GEOMETRY I

The way CAD and DCC applications de-
scribe geometry is vastly different as well.
CAD models are typically solids-based,
utilizing feature-based modeling, B-Rep,
CSG, or even a combination of these
standards. In simple terms, this means
that CAD models carry volume to allow
designers to integrate properties such as

| weight, inertia, and center-of-gravity. In

most cases, our rendering applications can
do without this “volume” data, and as such,
artists tend to model the exterior extremi-
ties of their models.

Most DCC applications are surface model-
ers. Typically, you will describe your surfaces
with either polygons or NURBS surfaces. To
mimic smoothing and NURBS surfaces, the
new mainstream modeling applications
utilize a methed of “subdivision” and use
terms like MetaNURBS, HyperNURBS, etc.
“Subdee” refers to a method of smoothing
a polygonal model using spline-smoothing
algorithms. While DCC applications may use
the term "NURBS," they are typically playing
on what NURBS means to smoothing model
geometry and are not utilizing the same
mathematical smoothing operations.

One last issue to be aware of is that CAD
models are derived by high-order B-Spline
based geometry, typically NURBS. “Subdee”
modeling is typically lower order spline
smoothing, usually Bezier or cubic-splines.
Where you find this may be a problem is
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TRANSFERRING CAO MODELS

in converting files that have a high order of
smoothing, and as such, will translate poorly
into polygons (more on this later).

THE TRANSLATION HURDLES
MODELING KERNELS AND DATA FORMATS

All applications utilize data structures and
modeling algorithms differently, and extract-
ing this information can be easy or tedious,
depending on the software manufacturer.
CAD software manufacturers typically utilize
modeling kernels that are proprietary, like
PTC's Pro/ENGINEER, Unigraphics (UGS).
Until recently, neutral file formats were the
only option used to translate geometry from
CAD systems to DCC applications. To extract
geometry from CAD systems, you had to
rely on the client to create the geometry
files from the CAD system, which can be a
win or lose situation. Typically, CAD vendors
only supported a limited volume of data
exchange formats, which were typically

non-polygonal.

A typical CAD system will support the

following neutral formats:
- IGES (.igs, .iges): Initial
Exchange Specification

« STEP (stp, .step): STandard for the
Exchange of Product

+ STL: Stereolithography format (triangu-
lated format)

» XGL: 3D information that can be ren-
dered by SGI's OpenGL rendering library

* VRMLZ (.wrl): Virutal Reality Markup
Language

+ ACS (sat)

- Parasolid (.x_t)

- OBJ: Wavefront object format (triangu-
lated format)

» 3D DXF: Autodesk’'s Data eXchange
Format

Graphics

Since CAD vendors held the cards, you
either had to interact with the client for
exported geometry or you had to own
a CAD system that the client used. Some
clients are more giving than others; where
some will just give an exported file, billion
triangles and all, others will work with you
in generating a clean file.

o5
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Presently, more CAD vendors are licensing
their modeling kernels to allow direct access
to feature geometry to assist in translations:

* PTC licensing Granite
+ UGS licensing Parasolid
* Spatial licensing ACIS

Now, with the CAD vendors licensing their
kernels, it has allowed format translation ven-
dors like Okino (www.okino.com) to develop a
native toolset (PolyTrans product) to use client
supplied native CAD files for translation. With
the native CAD file, you now have the ability to
tweal the export of the files for your needs.

GEOMETRY ISSUES

We've covered a lot of ground looking
at what makes CAD applications and DCC
applications different and a little into what
makes a CAD model unique. We'll shift our
focus now to extracting the geometry from
a CAD system.

Few DCC applications deal with NURB
surfaces well, unless modeled natively in the
application. Even SOFTIMAGE [XSI, Maya, and
3ds max have a hard time importing larger
sized IGES files; it is not uncommon that a
20 or 30 MB IGES file will import very slowly,
and in fact, IGES files are commonly known
to reach 100MB or more, which will render a
DCC application unresponsive. At some point,
tessellation needs to occur to break down
our smooth spline surface geometry into an
approximation of triangles or polygons. For
all intents and purposes, our CAD geometry
is 100% accurate, and no matter what tessel-
lation we use, we will lose that accuracy when
converted to a triangle or polygon mesh.

HIERARCHY (PARENT-CHILD TREE)

When you are dealing with assemblies of
parts in a CAD system, maintaining the hier-
archy relationship (assembly structure) adds
another complexity to our data exchange.
Typically, DCC applications will not recognize
a hierarchy (assembly structure) unless you
use an intermediate translator, like PolyTrans,
or a system of color-coded parts.

There are some formats that are able to

contain hierarchy; however, a lot is dependent
on the DCC application’s importer. Neutral
files that support hierarchy:

« IGES

- STEP

* Parasolid (x_t)
« ACIS (.sat)

EXPORTING FILES FROM CAD SOURCE =

For this section the reference software
referenced:

+ PTC's Pro/ENGINEER Wildfire 2.0
+ Okino’s PolyTrans v4.19

- NewTek's LightWave 3D v8.0.1
- SOFTIMAGE IXSI 4.2

- Cinema 4D XL 9

Typically, we can identify our translation
needs as either small or large. The process
that | discuss is fundamentally identical
between the two needs, except in the large
circumstance, we introduce the translator
middleman, PolyTrans. One thing to bear in
mind is that as | show the export process from
Wildfire; we can substitute Wildfire (or other
supported CAD) with PolyTrans in most cases,
because PolyTrans supports the Granite kernel
and can therefore open Pro/ENGINEER parts
and assemblies natively. Obviously, if Okino
does not make a native plug-in for your CAD
software, then you are required to use a neu-
tral format from your CAD software first.

EXPORTING SMALL DATASETS

I define small datasets where | am
translating 1to 50 parts where the data is
quite manageable in the CAD system.

ACCEPTABLE FORMATS I

Almost any format will be useful, but
special considerations for maintaining

hierarchy are marked with an

+ IGES*

SPASTEDS

+ Parasolid”

« ACIS*

+ OB| — Wavefront

*+ STL - Stereolithography




If you are dealing with a heavily struc-
tured tree, | recommend using PolyTrans.

EXPORTING LARGE DATASETS S

I define small datasets where | am
translating 50 or more depending on the
complexity of the geometry. The best
formats to export are:

+ CAD Native File (Pro/E, SolidWorks)
+ IGES™ assembly
+ STEP* assembly

When dealing with larger assembly sets, |
would recommend using a tool like PolyTrans.
The tools within the program allow you to:

+ restructure hierarchy
+ tessellate NURBS surfaces
+ perform polygon reduction

GENERAL CONCEPTS WHEN EXPORTING
FROM A CAD SYSTEM I

Using PolyTrans solves a lot of issues
of translation; however, if you are faced
with exporting from a CAD system, there
are issues you should be aware of and
understand how to handle.

COORDINATE SYSTEMS I

The equivalent of a “pivot” point or
“center” in a DCC application is the co-
ordinate system in CAD. If you want to
define a center or pivot point for a model
you are taking from CAD to your DCC
application, you will want to define or
use a consistent coordinate system. The
coordinate system is especially important
when you are exporting a large assembly
in reduced subassemblies (whether it is
for organization or size constraints). By
defining a consistent coordinate system,
you will find that when opening translated
CAD models, they will locate themselves
based on their coordinate system.

MESH DENSITY
(applicable when using STL, OBJ type export)

When setting the mesh size, you must be
aware of the concept of the “bounding” box.

EXAMPLE: WORM GEAR SHAFT MODELED IN CAD

EXAMPLE: WORM GEAR SHAFT WITH A FINE ANGLE CONTROL, FINE CHORD HEIGHT

The mesh density is a formulation based on
the bounding box of the model and can there-
fore yield extremely faceted meshes for small
features (such as fillets) when the relational
size of the model is very large in comparison.

Typically, a bounding box is determined
by a diagonal measurement from the
default coordinate system to the furthest
extremity. This can pose a problem when a
part or assembly is modeled “far” away from
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TRANSFERRING CAD MODELS
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EXAMPLE: WORM GEAR SHAFT WITH A MED

IUM ANGLE CONTROL, COARSE CHORD HEIGHT

EXAMPLE: RENDERED WORM GEAR SHAFT, VARIED MESH DENSITIES

the default coordinate system. Therefore, if
you are dealing with a part or assembly that
is rather large and not centered about the
default coordinate system, you may want
to center the model about the default coor-
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dinate system and take note of the offset.
Apply the offset when you import the
model to your DCC application.

CAD systems will generally tessellate

surfaces based on two parameters (some-
times hidden behind a simplified GUI):

* CHORD HEIGHT: The chord height is
defined as the distance between the chord
and the actual surface. A smaller chord
height value will result in more facets

* ANGLE CONTROL: Angle control regu-
lates the amount of additional improvement
provided along curves with small radii. An
angle control value of 1.0 provides maxi-
mum curvature improvement.

Generally, I find that if the geometry is
primarily round or cylindrical in topology,
a medium coarse mesh with an angle
control of 0.9 yields a good result. Setting
the angle control for objects primarily
square is of little use, even when dealing
with fillets.

With the examples at left, you should
see the difference when using a higher
chord angle value with a round object.
You will notice most in the fillets in the
grooves,

With the render at left, you will notice
the difference in mesh density where the
top gear to bottom gear show a transition
in modifying values. The bottom gear used
twice the resolution in triangles to over-
come some of the stippling you see with
the two topmost gears.

IMPORTING FILES INTO YOUR DCC
APPLICATION N —

The last step to completing our file
transfer is to import the file into our DCC
application. At this time, you've either
received or created a neutral file from the
CAD application or have used PolyTrans to
open a native CAD file.

Translate the file into an acceptable
format for your DCC application; again,
this is where | emphasize the use of Poly-
Trans for the convenience of being able to
export the file into a native format. If you
are not using PolyTrans, convert the file
into an acceptable format that your DCC
application will read.




USING POLYTRANS I

Utilizing PolyTrans gives me a wealth of
options. Whether I'm dealing with a neutral
format or a native CAD file my process is the
same. While the model is open, [ typically:

+ Review and optimize the hierarchy

- Utilize PolyTrans' polygon reduction

+ Utilize PolyTrans' polygon refinement
tools

PolyTrans has tools when dealing
with hierarchy files to optimize them
for export, typically advantageous when
dealing with IGES files.

PolyTrans’ polygon reduction tool is very
good in my opinion, and even utilizing an 80%
reduction rate, the models render very well.

The polygon refinement tools in PolyTrans
will allow me to merge triangles to leverage
as many “quads” (4-sided polygons) as
possible and also to create planar polygons
based on some factor. Using this option will
benefit you when you try to leverage the
subdee options in SOFTIMAGE [XSI, Cinema
4D, or LightWave, for example. Currently
in LightWave only quads are supported,
so utilizing the tools in PolyTrans, | can do
a lot of upfront work to prepare a model
to leverage MetaNURBS, if required. Using
the planar polygon processing will help
alleviate the rendering errors produced by
non-planar quads.

IMPORTING NEUTRAL FILES INTO A DCC
APPLICATION

If you are not using PolyTrans, you will
have to do a lot more manual work in
cleaning up your geometry import. Some
applications are better at polygon reduction
and geometry optimizations than others,
and unfortunately that is an article into itself.
However, | will highlight:

+ SOFTIMAGE IXSI has very strong poly
reduction tools

+ LightWave has a reasonable third-
party reduction plug-in QEMLOSS 3
(http://amber.rc.arizona.edu/Iw/
gemloss3.html)

+ LightWave has nifty third-party
triangle to quad tool mergetrigons x
(http://www7.wisnet.ne.jp/~dprj/
Iw_tips/guest_p_e.htm)

However, even with these tools, at
times you may need to recreate geometry,
especially if you are dealing with organic
type surfaces or highly convex or concave
surfaces which are hard to triangulate.

MODEL SCALE

The last area that really confuses a lot
of people is the area of scale. Be aware
that neutral files are unitless, but your
DCC application’s interface will interpret
the values to their default unit system.
For your reference:

+ 3ds max (Discreet) — Inches
+ Inventor5 (Autodesk) — Centimeters
+ LightWave (NewTek) — Meters
* Maya (Alias IWavefront) — Centimeters
* Rhino (McNeel and Associates) —
Millimeters
* Pro/ENGINEER (PTC) — Inches
Therefore, if you are importing a file
from a CAD system, you will want to make
the accommodation for its scale. If your
DCC application is metric based, you will
need to apply a scale factor in your DCC ap-
plication or in PolyTrans to accommodate
the difference in meter and inch systems.
I also find it useful to model a unit cube in
the DCC application and the CAD system to
serve as a double check. Unless you trust
your client, you can never be sure what
they are exporting, unless you are the one
doing the export. Scale is most important
when dealing with “real-world” kinematics
and forensic type animations. &

DEFINITIONS

Boundary Representation, a way
of describing a part by its vertices,
edges and faces

Computer Aided Design

Computer Numerical Control
Digital Content Creation

Nonuniform Rational B-Splines
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~ DESIGNAND RENDERING.
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BY WILLIAM “PROTON” VALIGHAN
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nimated short films
are nothing new, but
in the past couple of

years the industry seems to have
exploded with amazing stories
told by some very talented
artists. From large companies
like Pixar to minnows like Out
of Our Minds, animated shorts
have been a proving ground
for technique and develop-
ment for quite some time.
Recently, some of the most
interesting shorts have come
from schools around the
world. Every three months a
new short film is created by
the graduating students at
the DAVE school for their
final project.

The December 2004
graduating class of the
DAVE School recently
wrapped up the produc-
tion of Batman: New
Times, a 10-minute
animated short written

and directed by |eff

Scheetz and yours

truly. This fast-paced

animated adventure
follows the exploits of
Bruce Wayne as his

SO GO crime fighting alter
s it ART ASTLM STRIEONES

ego — Batman. Bruce
KCLADNER vare DecT =

e o tAMBT risks everything to

D A\'E S s e ~unol.CON deliver Gotham City
¥ 'r\v\f\ WW W\ o B AW BT _ ; from the vile Joker,
. A A ’ while he and his hench-

AT PROQ“C\'@"_‘ e

- NEW TIMES MOVIE POSTER men do all they can to spoil Gotham's New
Year's Eve party. Villainess Harley Quinn

od : — OFFICIAL BATMAN
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PROJECT HIGHLIGHTS

¢ Over 10 minutes of full CG animation «
* Over 1000 CG characters
* Over 50 sets »

An all-star cast including: Adam West, Mark Hamill,
Courtney Thorne-Smith, Dick Van Dyke, and more.

joins the fray, throwing everything she can
in Batman's way.

Batman: New Times involves over one
thousand characters, over fifty sets, and
more than twenty vehicles. Every set,
every prop, and every character was
precisely modeled according to strict
scale specifications. Almost every loca-
tion, vehicle, and character could have
been built from Lego blocks. To research
this project and aid in set design, The
DAVE School purchased over 100 Ibs.
of Lego blocks from sellers on eBay.
We worked closely with Art Asylum in
creating the stars of the film and based
them on Art Asylum’s MiniMate toy
line (http://www.legionsofgotham.org/
AAMiniMates.html). Art Asylum sup-
plied us with everything we needed in
the form of reference material, including
the actual toys!

Working with Los Angeles-based Voice
Director Michael Hack, The DAVE School
assembled an all-star cast of voice talent
to match the high-voltage animation of the
December Graduates. TV's original Batman
— Adam West — signed on early to this
exciting project. Fans of the original series
will recognize his signature style and over-
the-top performance. Mr. West is joined
by Mark Hamill, reprising his role as the
Joker from Batman: The Animated Series.
As a huge fan of the original 1960s Batman
television series, Mark Hamill was thrilled
to perform his Joker alongside his favorite
Batman, Adam West! As Catwoman, we
cast the talented and charming Courtney
Thorne-Smith. She loved the idea of doing
something her kids would enjoy. Dick Van
Dyke rounds out the celebrity cast, lending
his voice to Commissioner Gordon.

As with all of the DAVE School projects,
we worked with well-known sound effects
company Sound “O” Rama on the original
score and custom sound effects. With so
much talent involved on the project, a lot of
pressure was on the team to pull it off. Tak-
ing on a 10-minute project with a cast of
thousands in just over three months might
sound crazy, but, not knowing any better,
we were up for the challenge.
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HOLY SHORTS, BATMAN!

Now that the project has come to an end,

I asked a few of the key players a couple |
rounds of questions in the hope of sharing |
an inside look at the making of Batman: |
New Times.

William: So guys, what role did the three
of you play on the project?

Alejandro Parrilla: | had many roles on
the production of this film. | modeled most
of the main characters and some of the
secondary ones. Batman/Bruce Wayne,
Joker, and Catwoman are characters that |
actually exist in Art Asylum’s MiniMates I
world and | had to match the action figures
as they are. Then | could get creative and
had more freedom to design characters like
Harley Quinn and Commissioner Gordon. |
also modeled, textured, rigged, and did the ‘
character animation for the entire Batcave
sequence from Bruce Wayne putting on
the Batsuit until the Batmobile takes off.

Lastly, I helped to pull out some of the
shots that needed some help to be finished
in order to meet deadlines.

Josh Adams: My baby in this project was .
the car chase through Gotham City. Since |
the beginning stages of the project, | was
very excited about the car chase scene. It
had the potential to be a beautiful-looking
sequence, and | wanted to do as much of
it as I could. I knew it was going to be a |
fun challenge that | was really hoping to
take, and when | was given a major part of
it by building the “Harley van,” I knew that
I was going to have a blast throughout the
project. The coolest part about doing the
van was that there was no toy or design
to work off of, so I got to be creative and
design the van myself. | had an “angry
armored van” concept in my head, and |
think | came out with a pretty good result.
My next challenge is actually building the
van out of real Lego.

After the modeling stage, | had a major
chunk of the car chase animation, and |
ended up building the light rig that was
used for the entire car chase. Working with
Alejandro, we worked out a basic setup
with expressions that would drive all of the
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CG MINIMATES DESIGNED BY ART ASYLUM WERE
USED AS THE CAST OF THE FILM

PLACE IN WAYNE MANOR AND THE BATCAVE
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GOTHAM CITY STREETS CAR CHASE BY JOSH ADAMS

cars in the city including the Batmobile and
the van. But overall, the car chase was my
largest contribution.

You can read how to set up the car rig
here: http://www.newtek.com/products/
lightwave/tutorials/animation/car_setup/
index.html

Sean Fitzsimmons: Since the project
was first introduced to us, | had it set
in my mind that | wanted to model the
Batwing. When | was assigned to actually
model it, | was extremely excited ... and
a little intimidated. The biggest challenge
was building the model to the precise
scale that we were given. Everything
had to line up and match the size of the
MiniMate characters that were also being
built to scale.

The next models assigned to me were
the Robin and Harvey Bullock MiniMates.
Once the models were finished, it was time
to put our scenes together. Since | had built
the Batwing and Robin, | asked to do the
sequence where Robin flies the Batwing

in to catch Batman after falling from the
Joker-copter. Once | started to get a feel
for the Batwing scenes they went pretty
smoothly.

Willilam: Three months to work on a
10-minute animated short is quite amazing
— what was the workday like?

Sean: The workday consisted of a few
different things. Most of the time was
spent focusing on whatever task was in
front of me. To maintain sanity there were
a few times where jokes and quotes from
Adam West were thrown around with
reckless abandon. And burritos ... lots and
lots of burritos.

As we neared the end of the project, the
nights grew longer and longer until finally
the workday turned into the work night and
then the work morning. Did | mention the
couches (read: beds) at the DAVE School?
One word. Comfortable

William: How did the team handle the
massive crowds in the movie?

Josh: The crowd shots were definitely
a major thorn in the proverbial side of
the Batman project. In some of the Times
Square shots, there were almost 500 Mini-

Mates in each shot, with many polygons
per character, so it added up quickly. In the
car chase, there were also many shots with
lots of characters that got to be a burden to
set up. First of all, each character had to be
moving. So by making a few generic walk
cycle animations and by using MD Scan
and MD Plug, we were able to add move-
ment to hundreds of MiniMates without
having to animate each and every one of
them, thankfully!

Also, there were some instances where
custom movements for the characters
were necessary, such as in a shot where a
MiniMate escapes death by jumping out of
the way of the oncoming Harley van. It is
little details like that that sold that shot, and
sold the show entirely.

William: What was your favorite part of
working on this project?

Alejandro: [ actually have many favorite
parts. | would probably highlight the
fact that we had Nicholas Boughen as a
guest speaker. He took a short break at
Rainmaker and came all the way from
Vancouver to share his vast knowledge
with us in a two-day lighting seminar. That
was unbelievable. | learned so much in that
short period of time.




HOLY SHORTS, BATMAN!

Sean: Modeling the Batwing was abso-
lutely my favorite part of the project and |
learned so much doing it.

William: Josh, you got to “co-star” with
Adam West playing the role of Robin.
What was that like?

Josh: Oh, you mean A.W.? He and I are
best friends now. He flies me out to his
house in L.A. all the time, and we play
X-Box and sip margaritas while floating
in his pool...Well, actually, | never got to
meet him, unfortunately, but the whole ex-
perience was cool. Listening to a seasoned
veteran of the acting world do his craft,
although over the phone, was an experi-
ence [ won't soon forget. | mean, come on,
he IS Batman. The recording process for me
was also lots of fun. | had been to recording
studlios in the past as a musician, but never
to as nice place as Sound “O” Rama. They
have a great set-up, and a very professional
atmosphere. | also got a laugh out of being
referred to as “talent.”

William: Alejandro, You spearheaded
bringing Mimic into the pipeline for lip
sync — can you tell us a little about using it
in production?

Alejandro: Well, at the beginning it
sounded like it was going to be a hassle to
add a brand new software to the toolkit, as
we dicdn't have much time for research and
development, but once you open Mimic
in the LightWave interface, you find out
it is rather intuitive and the steps for the
whole lip sync process are pretty straight
forward. It took me just a few hours to read
the documentation and [ was ready to go. |
look forward to using it on future projects,
as | know it will make quick work of any lip
sync work thrown my way.

William: Were there any challenges dur-
ing the making of the film?

Josh: I guess the biggest challenge of the
project was working with very specific Lego
designs. Every single model of the project
had to be re-creatable in the Lego universe
using standard bricks, so that threw us a lot
of curves when trying to decide how some-

:EF HDRI 3D I1SSUE3

= B
¥, P L ) | @GN GEEEE
‘:ﬂ_ml}LLﬂ 5| ]

SEAN FITZSIMMONS RECREATED THE ART ASYLUM BATWING TOY PIECE BY PIECE

thing would look. Something that would be
relatively easy to model was extremely
difficult to recreate using Legos.

Another challenge was the massive
size of some of the scenes. In one of the
car chase scenes we had 30 Lego build-
ings, 25 cars, 150 MiniMates walking on
the sidewalk, the Batmobile, Batman, the
Harley van, Harley Quinn, her driver,
particles, street lights, and a fire hydrant
— a pretty massive scene that had to be
broken up, but we pulled it off and it looks
great. Lighting was also a major concern in
this project. We were having difficulty with
how to pull off the nighttime look while be-
ing able to see all of the action, so | emailed
Nick Boughen and asked for his input on
some renders we had done, and with his
help | feel we pulled off the nighttime
street look beautifully. I just hope he feels
the same way ...

Sean: A big challenge for me in this proj-
ect was working with particles. This was all
experimentation for me and at one point |
was very close to just giving up. | packed
up for the night and spent the night going
over the experimentation of the previous
six hours in my head. Somewhere in the
middle of the night the solution hit me.
Trumpets blared and | was engulfed in

SEAN FITZSIMMONS AND LARRY MOORE ANIMATED
THE FINAL SEQUENCE IN JUST UNDER THREE DAYS




JOSH ADAMS VOICED ROBIN ALONGSIDE ADAM WEST PLAYING BATMAN

light. | came to school the next day and
within ten minutes had the problem (a mis-
sile trail) resolved.

William: Any tips you learned during the
production of the film that you would like
to share?

Alejandro: One day | was trying to figure
out the best way to make the model of
the Batcave — try to imagine modeling
the bumpy walls of the Batcave out of
Lego pieces. It would take forever and
the polygon count would make the scene
impossible to render in short time. | got a
nice tip to model using dynamics in Layout
from Jonny Gorden. | wanted to recreate a
sub-patch model I had designed, translated
into the Lego world, so all | needed was to
use the sub-patch version of the Batcave as
a collision object, and a grid of unwelded
polygons to match the size of the Lego
blocks. By applying hard body dynamics to
this object and making it fall vertically on
top of the collision object with the proper
settings, the grid would get the shape of
the Batcave as it falls and collides, letting

you save the end result as a transformed
object. Then all you have to do is clean up
the geometry back in Modeler, extrude the
grid, and voila! You got a Lego Batcave
wall. Thanks for the tip, Jonny!

Sean: The biggest tip | can think of
came while | was modeling the Batwing.
Once the model was done and | went to
do some renders of it, | found that the
curves in the wings didn't have enough
segments and looked too faceted. | was
getting nervous thinking | was going to
have to redo the wings. That's when |
learned about a new tool in LightWave
[8] called Edge Bevel. | went around the
wings and at each of the segments, |
selected the edge that was too sharp and
applied the Ecige Bevel. This split the edge
into two, rounding out the edges of the
curves. Very handy tool, and it saved me
from remodeling the wings.

William: Now that you have experience
producing an animated short, what advice
would you give to someone wanting to
work on one?

Alejandro: [ would encourage people
to go through the process of making an
animated short. My best advice is to es-
tablish a structure so you can sail smoothly
through the whole process. Establish
deadlines on a daily basis. Be organized.
The more disciplined you are the better
the result will be. Use references. Always
try to keep getting feedback from other
artists; otherwise, you could be at the risk
of falling into a labyrinth, which could take
a while to get out from, and you may miss
your deadline.

Sean: Organize. One thing | started
doing toward the end of the project
was keeping a “diary” of shots for the
day. | used that to keep track of what |
had done the day before and was ready
the next day to check the renders. The
shotlists we were given also added to the
organization. We could mark off what
was animated, lit, approved, and finally
rendered. Another important piece of
organization was our directory structure
and naming convention. Working with 20
people on a project really drives home the

@
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HOLY SHORTS, BATMAN!

NEW TIME
OBILE AND BATC

ARTISTS: WING LUNG & ALEIANDRO PARRILEA

FINAL BATMOBILE AND BATCAVE CREATED BY WING LUNG AND ALEJANDRO PARRILLA

need to name your scenes in the same
way and keep things organized so that
anyone in the group can pick up your
scene and continue working.

Josh: Well, | guess the best advice |
can give could be applied to any project,
whether short term or long, is to set short
term goals so that you get the project done
in a timely manner. The hardest part of do-
ing this project was finishing it. So | guess |
could say to see the project through to the
end. As William would always say, ‘The last
10% of the project is 90% of the work, " and
I am now an advocate of his wisdom.

Working on a Batman animated short
and working with an all-star cast was
amazing. But nothing can ever really
compare to sitting back and watching
a movie that you had a hand in creat-
ing. | would like to encourage everyone
to work on an animated short at some
point in their career. You will take away
far more experience then you could ever
imagine. | hope you enjoy our film! &
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FROM LEFT TO RIGHT, ALEJANDRO PARRILLA,
JOSH ADAMS, AND SEAN FITZSIMMONS

.

Times, visit: http://www.daveschool.com

montage created by the class, down-
load the QuickTime movie from here
(20MB):
ftp://ftp.newtek.com/multimedia/
movies/Slideshow_2004.mov

~

To find out more about Batman: New

To see a behind the scenes photo

WILLIAM “PROTON" VAUGHAN
A RECIPIENT OF SEVERAL
NEW MEDIA ADDY AWARDS,
WILLIAM HAS AN EXTENSIVE
BACKGROUND IN CREATIVE
3D FOR PRINT, WEB,
MULTIMEDIA, GAMES AND
BROADCAST. DURING THE
LAST 10 YEARS, HE HAS

~ DELIVERED  AWARD-WIN-
NING WORK FOR CLIENTS SUCH AS COMPAQ, NEW
LINE CINEMA AND HALLIBURTON. WILLIAM HAS
ALSO TRAINED ARTISTS AT SEVERAL STUDIOS AND
SCHOOLS AROUND THE WORLD AND CONTRIBUTED
TO SIX LIGHTWAVE 3D BOOKS THROUGHOUT 2003
AND 2004,

IN 2002, VAUGHAN JOINED NEWTEK'S MARKETING
TEAM AS THE LIGHTWAVE 3D EVANGELIST, WORK-
ING CLOSELY WITH THE LIGHTWAVE DEVELOPMENT
TEAM, KEY ACCOUNTS, AND THE GROWING
NUMBER OF END USERS TO ENHANCE LIGHTWAVE'S
FEATURES SET.

WILLIAM IS DIRECTOR OF INDUSTRY RELATIONS AND
INSTRUCTOR OF THE DAVE SCHOOL 'S UPCOMING
FINAL PROJECT. WILLIAM'S FOCUS IS ON CONTINU-
OUSLY IMPROVING THE QUALITY OF EDUCATION AT
THE DAVE SCHOOL, WHILE FURTHER ESTABLISHING
THE SCHOOL'S PRESENCE IN THE INDUSTRY.
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BY EODO HARRISS

Computer
Animation
Job Hunting
Tips —

|

IN ORDER TO OBTAIN A JOB IN THIS INDUSTRY YOU HAVE TO
FIND A WAY TO STAND OUT FROM THE CROWD.
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one are the days when

it was easy to get a 3D

job. It's an employers
market now. Applicants really
have to stand out in order to
get hired. In this article, you'll
find dozens of tips on how to
get noticed in today’s crowded
computer animation industry.

Things not to do: Often it seems that many job hunting CG
artists need to know better what not to do rather than what to do.
For example, don't bad mouth your previous employer, no matter
how much you might hate them. Leave satanic, erotic, and violent
material off of your demo reel. Do not put color bars and sample
tone at the beginning of your reel. Do not ask for your reel to be
returned after it is viewed. Never send out the original copy of

your reel. Don’t send the same reel in over and over. (Animators
have a very good visual memory and will notice.) No “works in
progress.” If it is not finished, don't put it on your reel. Don't put
tutorials or tests on your reel unless you have drastically altered
or improved them. Don’t show any “plug-in animations” either.
That is, don't put anything on your reel that only looks interesting
because you used some “cool new plug-in” to make the effect.
This should almost go without saying, but never put other people’s
work on your reel unless you worked on the project with them, and
NEVER put work on your reel that you had nothing to do with. If
you are sending out VHS tapes, always rewind the tape before you
send it out. Be kind, please rewind.




IN ORDER TO OBTAIN A JOB IN THIS INDUSTRY YOU HAVE FIND A WAY
TO STAND OUT FROM THE CROWD.

Reels: Your reel is one of the most important tools you'll use
to get work. Consider it your calling card. Most demo reels must
grab the interviewer's attention in the first 30 seconds or they're
not going to look at the rest. (They are probably watching it during
lunch and don'’t have time.) If they don't like what they see, they’ll
fast-forward the reel, running the risk of missing something good.
Keep the length under 3 minutes, even if you've got 15 minutes of
great work.

WITHOUT AN EYE-CATCHING DEMO REEL YOUR FUTURE EMPLOYER WILL
SPEND MORE TIME WITH THEIR HAND ON THE FAST FORWARD BUTTON
THAN THEY WILL WATCHING YOUR MATERIAL

e -

It's very important that you put your best work at the beginning
of the reel. Never put anything on your reel that you have to think
twice about. If you are going to have to make excuses for the poor
quality of a certain segment, leave it off. Bad work often stands
out more than good work. Make sure that your work demonstrates

your abilities and creative talents. It needs to show that you have
the ability and skills to do the work. It's not a good idea to repeat
any segments on your reel. It will only look like you are trying to
meet some sort of artificial “time requirement.”

Creativity: It's a good idea to show creativity in your work. Your
reel will get a lot more respect if it contains new and original work,
rather than another Matrix rip off. You are not the first one to animate
a space battle or dinosaurs or robots or tanks. If you are a student, or
you are making your demo reel at home, then chances are you can
do whatever you want. Pick something that you enjoy, something
that other people have not done over and over. This expression of
creativity has the potential to impress the viewer and help your reel
stand out from the crowd. The easier it is for them to remember your
work, the better your chances are of getting hired.

TRY TO BE ORIGINAL. NO MORE SPACE BATTLES, DINOSAURS, ROBOTS OR
TANKS. DEMO REEL REVIEWERS ARE GETTING VERY TIRED OF SEEING THEM

h S R A B

Creativity is good not only in the animation, but in the way
it is put together. Make your reel unique with some interesting
editing, packaging, and music. It will really help you stand out.
Don’t spend an obscene amount of time on this area, but don't
dismiss it entirely either.

Portfolio: If you are a good 2D artist (drawings, paintings,
photography, etc.), include prints of your artwork with your
reel. If that is not possible, then scan in your work and include
it on your reel. Same goes for 3D work, such as sculptures and
installations. Companies are more likely to hire a good modeler
that can also sculpt, as opposed to someone who can only
model in 3D.
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JOB HUNTING TIPS
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WHICH TYPE OF SCHOOL IS GOOD FOR YOU?

e
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Education: Education is a very important step in getting a
computer graphics job. There are basically three educational paths
available to you: attending a university, attending a specialized
school, or teaching yourself. Everyone has different needs when it
comes to education. Which one is right for you?

A university education will typically consist of a broad education
where you will learn many things that have nothing to do with
your future job. Believe it or not, that is one of the main benefits
of attending a university. When you graduate, you will be a well-
rounded individual that will be able to tackle a wide variety of
problems relatively easily. Another benefit is that you'll have a long
time to develop your skills, as typical university degrees take at
least four years to earn.

UNIVERSITY EDUCATION IS SO BROAD THAT IT OFTEN PRODUCES

ANIMATORS WITH WELL ROUNDED SKILLS

A specialized school will consist of a more focused education
where you will learn exactly what you need to hit the ground
running the instant you graduate. These schools also tend to react
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faster to hardware, software, and industry changes. As a result, your
education will probably be a little more “up to date” than a traditional
university education. Schools like this will also offer you more “hands
on” instruction. Since the classes tend to be more focused, there will
probably not be any history, language, or philosophy classes. These
schools are also an easy way for people who already have a job to
change careers quickly or refresh their skills.

SPECIALIZED SCHOOLS OFFER A MORE FOCUSED EDUCATION

What about teaching yourself? It can be done, but you have
to be very dedicated to do it well. If you are the type of person
that needs someone standing over your shoulder or someone
giving you deadlines in order to get things done, then the
self-taught route is not for you. However, if you are good at
scheduling your time, able to learn from reading manuals (rather
than having some one show you), and you have the dedication
and the equipment, then the self-taught route might just be for
you. Many people go the self-taught route and flake out after a
few months. Don't let this happen to you. If you even think that
it might, then go to school instead. There is something to be said
for having others around you when you are trying to learn CG. If
you go the self-taught route, try applying at smaller companies
first. They may have fewer formal educational requirements and
may be more willing to zero in on your knowledge and skills
rather than where you acquired them.

TEACHING YOURSELF COMPUTER ANIMATION CAN BE A DAUNTING TASK
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None of these three routes are “better” than the other. In
fact, some of the best CG artists out there are often a result of
a combination of these three educational paths. Different people
have different needs. There are pros and cons to each of the three
types. The university route will take you longer and might not give
you the specific knowledge that you need to know, but you'll have
more time to develop your demo reel and you'll learn things that
you'd never learn in a specialized school due to time constraints.
Going to a specialized school might increase the chances that
you'll get a job immediately after you graduate, but the broad
range of knowledge that you'd gain at a university might be more
important to you down the road. If you go the self-taught route,
you’ll save a lot of money and you'll be able to learn exactly what
you want, but without structure and interaction with other CG
artists, you might not be able to learn what you need to become
good enough to get a job.

Tools: Some students get a little too obsessed with what they
might think is the best animation tool. There are hundreds of com-
panies that are using their own proprietary software. Students will
probably not learn the exact tools they'll need when they enter the
industry. It is best to learn the software that you can get your hands
on. A student might learn SOFTIMAGE IXSI, 3ds max, LightWave,
or Maya as their main software. While this is a great idea, most
companies are looking for people who are good at solving prob-
lems, not just pushing buttons.

DONT BECOME OBSESSED WITH A PARTICULAR
SOFTWARE TOOL. LEARN THE BASICS FIRST

RESUMES AND COVER LETTERS:

Unless you've had dozens of jobs in a very short time, don’t use
your resume to explain why you left a job; leave the explanations
for the interviews. Employers hate it when they have to guess what
you are trying to say in order to decipher your intent. Avoid rarely
used or very large words. Don't write complicated and confusing
sentences. Cover letters and resumes are not excuses for you to
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SPEND A LITTLE EXTRA TIME ON YOUR RESUME.
IT MIGHT BE MORE IMPORTANT THAN YOU THINK

show off your storytelling ability or vocabulary knowledge. Keep
the information concise and straight to the point.

Resumes take longer to write than you might think. It is also diffi-
cult to come up with all the relevant information instantly. Spending
a small amount of time on a resume every day for a week is much
better than trying to write it in one sitting. This way, it will be much
easier to add in things as you remember them.

Be a Team Player: No matter how good you are, you won't
last in this industry unless you can work well with others. The ability
to share information with your co-workers and get along with them
at the same time is very important.

BEING A TEAM PLAYER IS VERY IMPORTANT IN THIS INDUSTRY
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Getting your reel and resume into the right hands: All
of this hard work will be wasted if no one sees it. There is a better
chance that a potential future co-worker will see your work at a
smaller company, as larger companies have a human resources
(HR) department that you need to get through first.

When you send in your reel to a company who is advertising for
jobs, HR is where it typically ends up. They usually have so many
reels to get through that they might not even get to yours. You
need to get your reel to a hiring manager or a “real” employee.
When you see a job posting, go to the company’s Web site and get
a name. Many company sites have employee profiles. Get the name
of whomever the open position is likely to report to. Once you have
their name, it will probably come with an email address. If it does
not, a little creative Web searching usually turns it up.
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Once you've got their email address, ask them if it is OK if
you send them your reel. When they get your reel, they will
either watch it themselves or give it to HR. Why go through all
this trouble when HR might get the reel anyway? Because the
HR department is looking at a reel that came to them from an
internal source, not just another outside submission. This makes
a huge difference in their eyes.

The bottom line: No one cares what school you went to or
how cool your computer is. All that matters is the quality of your
work. If you are a good CG artist, then you'll get a job. Don’t worry
if it is taking longer than you expected to find a job. It only takes
one, and there are thousands of them out there. @
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CURRENTLY, ED WORKS AS A TECHNICAL DIRECTOR AND 3D ARTIST AT SAS
STUDIO PRODUCTIONS, A PRODUCTION COMPANY IN RALEIGH, NORTH
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ING SOFTIMAGE(XSI ARTISTS, RUNS ONE OF THE LARGEST SOFTIMAGE|XSI
RESOURCE SITES, AND TEACHES SOFTIMAGE|XSI OVER THE INTERNET VIA
MESMER, INC. MORE INFORMATION ABOUT ED HARRISS CAN BE FOUND ON
THE WEB AT: WWW.EDHARRISS.COM
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BY BERNARDO LEBEL

PN SOETS

ne of the areas where SOFTIMAGEIXSI shines is

rendering. The artist has a large rendering toolset:

passes, overrides, satellite rendering, batch rendering,
command line rendering, and so on. Now BatchServe ships
freely with SOFTIMAGE IXSI, which opens a lot of possibilities for
network rendering.

All these features make SOFTIMAGEIXSI a serious rendering
solution. However, there is a way to take all of this and bring it
further: scripting. Out of the box, the rendering tools are great, but
they often require some work from the artist, and lots of repetitive
tasks are involved. Used through scripting, rendering can become
a real fun experience, where repetitive tasks, boring work, and
cumbersome workflow can be minimized.

In this article, we will explore some of the possibilities scripting
offers to rendering artists. We will cover many topics. We will not
go too deeply into each of them, but instead | will give you the
information you need to get the scripts done, like relevant notes
about the SOFTIMAGE IXSI object model, system commands,
programming tricks, plus many code examples.

This article is intended for users who are somewhat proficient
with scripting. It need not be advanced proficiency (this article is
not advanced), but being familiar with the object model, param-
eters, looping techniques, and the like will definitely help. In this
article, | will use Python as the scripting language, because this is
my main language.

INSTALLING PYTHON

If you are a Windows user, Python is not supplied with Win-
dows; it has to be installed separately. You can download the
installer here:

http://www.python.org/download/

You may download Python 2.3.4 or 2.4, but keep in mind that |
have not tested the latter so | can’t garantee my examples will work
perfectly in it. You will download an executable file. Run it, and choose
a location for installing the Python directory. You should install it at the
root of a drive, simply because it will make paths shorter.

Once this is installed, you will need the pywin3Z module:
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http://prdownloads.sourceforge.net/pywin32/pywin32-203.
win32-py2.3.exe

Install this executable; this will make Python an available language
in SOFTIMAGE IXSI. You see, SOFTIMAGE [XSI uses active languages
for scripting. In short, active languages are languages that can
create active objects. Active objects are used to interact with other
softwares and the operating system. The pywin32 executable will
install the active part of Python, which will make it available in
SOFTIMAGE IXSI.

Launch SOFTIMAGE [XSI, and choose Python ActiveX Scripting Engine.

Linux users do not have to worry about this, because Python is
supplied with most builds of Linux (at least the ones supported
by SOFTIMAGEIXSI), and the active binaries are supplied with
SOFTIMAGE IXSI Linux. However, if you are using an old build of
Linux (like Fedora Core 1), you may want to upgrade Python to a
more recent version. Here | can’t help you, as I've never installed
anything myself in Linux.

A FEW USEFUL TIPS

Python has its particularities in SOFTIMAGE IXSI. It does not
behave exactly as the other langages, so you have to be aware of
a few things. The following things can be found in the scripting
documentation, but | summarized them for your convenience.

+ Use None to specify a null argument.

+ True and False require a capital first letter.

* You can use single and double-quotes for strings.

* You have to use the Application class for commands, including
SOFTIMAGE IXSI and custom ones. To call a command, use:

Application.commandname()

You can instantiate the Application class to something
shorter, like xsi.

* You also have to use the Application class for things like
activesceneroot, selection() and classname().
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- To use constants, you need to import them. | recommend you # Get passes

do it this way:
oPasses = xsi.activeproject.activescene.passes

from win32com.client import constants as ¢
‘ xsi.logmessage( ‘I have ' + str(oPasses.count) + * passes in the scene.”)

This will import the constants class and instantiate it as ¢ (much

shorter) in one go. # lterate individual passes
Now when you want to use a constant, you can do it this way: ' for oPass in oPasses:
olLights = xsi.activesceneroot.findchildren( *, c.siLightPrimType, None, True ) xsi.logmessage( ‘Pass name: ' + oPass.fullname )
oLights = xsi.SIFilter( None, c.siLightFilter, True, c.siQuickSearch ) Now this is where it becomes tricky. Despite the RenderOptions
object being a property, you can’t access it as if it was a property.
xsi.logmessage( ‘Hello XSI world!', c.silnfo ) | This will fail:
Another tip with constants is that once you have imported them, oProp = oPass.properties( ‘RenderOptions')

instead of using the class, you can use a string:
Instead you have to get the object from the SOFTIMAGE IXSI

oLights = xsi.activesceneroot.findchildren( ", ‘'siLightPrimType', None, True ) dictionary:
|
oLights = xsi.SIFilter( None, ‘siLightFilter’, True, ‘siQuickSearch') oProp = xsi.dictionary.getobject( oPass.fullname + *.RenderOptions’ )
xsi.logmessage( ‘Hello XSI world!', ‘silnfo’) Now you can access any parameter from the render options:
\
+ To create an XSlCollection and other SOFTIMAGE IXSI native # Get passes
ActiveX objects, you need to first import the win32Zcom module,
then dispatch the win3Z2com class and create a SOFTIMAGE IXSI | oPasses = xsi.activeproject.activescene.passes

factory intrinsic object:
# lterate individual passes
import win32com
for oPass in oPasses:
xsifactory = win32com.client.Dispatch( *XSI.Factory' )
xsi.logmessage( ‘Pass name: * + oPass.fullname )
oCollection = xsifactory.CreateObject( ‘XSI.Collection’)
# Get pass render options
* One of the big problems with Python in SOFTIMAGE [XSl is that most

of the time you deal with object pointers, and not objects themselves. So, oProp = xsi.dictionary.getobject( oPass.fullname + * RenderOptions’ )
when you try to access parameter values, you get COM errors and such.
To deal with this, make sure to get the object via the scene dictionary: # Print end frame value for this pass

oLights = xsi.SIFilter( None, c.siLightFilter, True, c.siQuickSearch ) xsi.logmessage( ‘Pass end frame: * + str(oProp.parameters( ‘End-

Frame' ).value) )
for oLight in oLights:
! When you create a new pass, you can either retrieve it from
oLight = xsi.dictionary.getobject( oLight ) the SOFTIMAGE IXSI dictionary, or you can find it in the pass list
of the scene:
Note that this technique will not work on object sub-components ‘
(vertices, edges, polygons, etc.). | # Create new pass

PASSES ‘ xsi.createpass( ‘Pass’, ‘MyNewPass’, None )
To access passes, you have to start traversing the scene hierar- oNewPass = xsi.dictionary.getobject( ‘Passes.MyNewPass')

chy from higher than the scene root: the active project.
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oNewPass = xsi.activeproject.activescene.passes( ‘MyNewPass' )

To list all the objects under a pass, you can run a low-level
command called EnumElements().

# With a pass selected, run enumelements to collect the objects under that pass
oElems = xsi.enumelements( xsi.selection(0) )
# lterate the objects under the pass
for oElem in oElems:
xsi.logmessage( oElem )

So after that, you will access pass objects like you did for the Ren-
derOptions, via the SOFTIMAGE XS dictionary. Let's say you want
to run through the Environment shaders. You can use the EnumEle-
ments() command on the EnvironmentShadersStack, because there is
no way in the object model to access this information:

# Get environment shaders stack of the selected pass

oEnvStack = xsi.dictionary.getobject( xsi.selection(0).fullname + *.Environ-
mentShaderStack’ )

# Get list of shaders from environment shaders stack

oEnvShaders = xsi.enumelements( oEnvStack )

# lterate list of environment shaders

for oEnvShader in oEnvShaders:

xsi.logmessage( oEnvShader )

PARTITIONS

Now that we know how to handle passes, we can start looking
into partitions. Partitions are a special case, because the way they are
displayed in the SOFTIMAGE XS interface doesn't match the way they
are structured in the SOFTIMAGE [XSI SDK. The two background parti-
tions are placed directly under the pass, but the other partitions, despite
being listed right under the pass like the background ones, are in fact
placed into a partition container, pretty much like environment shaders
are placed in the EnvironmentShaderStack container. The difference is
that the partition container is not visible in the SOFTIMAGE XSI inter-
face, which can lead to lots of script errors.

So if we go back to one of our previous examples:

# Get selected passes objects

oElems = xsi.enumelements( xsi.selection(0) )
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# lterate objects under pass
for oElem in oElems:
xsi.logmessage( oElem )
This would print:
#INFO : Passes.Default_Pass.Partitions
#INFO : Passes.Defaulf_Pass.Background_Objects_Partition
#INFO : Passes.Default_Pass.Background_Lights_Partition
#INFO : Passes.Default_Pass.RenderOptions
#INFO : Camera
#INFO : Passes.Default_Pass.EnvironmentShaderStack
#INFO : Passes.Default_Pass.OutputShaderStack
#INFO : Passes.Default_Pass.VolumeShaderStack
#INFQ : Passes.Default_Pass.Name
The first object printed, Partitions, is the partition container |
mentioned above. To list the partitions it contains, you have to once
again use an EnumElements() command on it:
# Get selected passis objects
oElems = xsi.enumelements( xsi.selection(0) )
# lterate pass objects
for oElem in oElems:
# Check if pass object has ‘Partitions’in its name,
# which means it would be the custom partitions container.
if ‘Partitions’ in str(oElem) and not ‘Background’ in str(oElem):
# Get the partition container elements (that is, custom partitions)
oCustomPartitions = xsi.enumelements( oElem )
# lterate partitions
for oPartition in oCustomPartitions:

xsi.logmessage( oPartition.fullname )

oPartition = xsi.dictionary.getobject( oPartition )




At last, you need to get the partition objects via the
SOFTIMAGE IXSI dictionary.

Once you have gotten to the partitions, you can start either
working on them or their members. In the SOFTIMAGE IXSI object
model, partitions are groups; they share the same properties and
methods. So, for example, if you want to print the number of ob-
jects a partition has, you can simply print the count property of the
partition members property.

xsi.logmessage( oPartition.members.count )

You can add a material to the partition with the addmaterial()
method. You can also add an override with the addproperty( ‘Over-
ride’ ) method.

To move objects from one partition to another, you can either
use the CopyPaste() or MoveToPartition() commands. Unfortu-
nately, the addmember() method, which works for groups, does
not not seem to work with partitions.

So far, we have seen how to move downward the object model to
get to partitions, but what if we wanted to move upward? Let's say
we have an object and we want to know not only the partition it is
a member of, but also what pass this partition is in.

To get the partition, we have to evaluate the owners of the object.
This will return a collection of at least two group objects; one is the
layer, the other a partition. In the SOFTIMAGE IXSI SDK, groups,
layers and partitions are all groups, with very subtle distinctions.
So, to giet to the partitions owning an object, you have to filter out
the layers, and then check if the owner of the group is a pass, which
means it's a partition. This is a lot of work, but it also allows you to
get to the pass object.

# lterate owners of selected object

for oOwner in xsi.selection(0).owners:

# Check if owner is a group, but not a layer
if oOwner.type == c.siGroup and not xsi.classname( oOwner ) == ‘Layer".
# Iterate owners of the group
for oGroupOwner in oOwner.owners:
# Check if group owner is a pass

if 0GroupOwner.type == ‘#Pass”:

xsilogmessage( ‘Pariion ' +
oOwner.name + * belongs to pass “ + 0GroupOwner.name + . )

SOFTIMAGEIXSI TUTORIAL

MATERIALS

There isn't much to say about materials, as they're generally
pretty straightforward to script. Each geometric and hair object has
a material property, which makes it easy to access them.

However, keep in mind that scripting-wise, a material is also a
property of an object and can be accessed like any other property.
So, as soon as you add a material to any object, including groups and
partitions, that object also receives an additional property object.

# lterate local properties of selected object
for oProp in xsi.selection(0).localproperties:
# Check if local property is a material
if oProp.type == c.siMaterial Type:
xsi.logmessage( oProp )

When looping over the properties of an object, if you are look-
ing for materials, it is very important that you iterate the local
properties rather than the properties. The problem is that an object
can receive two materials simultanously: one is local, the other is
applied (inherited). If you print the properties of the object, only the
local one will be printed. However, if you print the local properties,
both of them will be printed.

NOTE: you can verify this by selecting an object, and apply a
material. Then branch-select the object, and apply another material.
Now, toggle the scope of the Explorer between Local Properties
and Applied Properties, and notice that one of them is not visible
when the scope is set to Applied Properties. Then run this code to
further observe the problem:

for oProp in xsi.selection(0).properties:
if oProp.type == c.siMaterialType:

xsi.logmessage( oProp )

xsi.logmessage( ' ")
for oLocalProp in xsi.selection(0).localproperties:
if oLocalProp.type == c.siMaterial Type:
xsi.logmessage( oLocalProp )
Finally, in SOFTIMAGE [XSI 4.0 and later, materials are no longer
exclusive properties of objects. Each material is an item of a mate-

rial library. To know the library owning the material, simply use the
library property on the material:
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# Print the library of the selected object's material

xsi.logmessage( xsi.selection(0).material.library )
SHADERS

As straightforward as scripting materials can be, scripting shad-
ers is all but straightforward. Shaders is an area where the user is
pretty much left to himself and has to use undocumented com-
mands and messy loops to get the result.

First, you can retrieve any shader in the scene very easily, with a
command not documented.

# Get change_range shaders, retums a collection

oShaders = None,

00A0C9892542}" )

xsi.findobjects( “{BDE291C1-077A-11D2-8A1A-

# Check if shaders were found
if oShaders.count > 0:
# Iterate found shaders
for oShader in oShaders:
xsi.logmessage( oShader )

This LogMessage() command will print not only the name
of the shader, but also the path of the shader. If the shader is
in a material, the full path to the shader will get printed. If the
shader is among the environment shaders of the pass, the pass
is printed.

Now what is that FindObjects() command all about? That big
set of characters and numbers is the ClassID of the shader. The
ClassID is a unique number that identifies the class of shader you
are dealing with. Each shader has its unique class, so by using
that class identifier, you can retrieve all instances of that shader
in the scene. To find out the ClassID of a shader, create the shader
in the Render Tree (or any other place where you can access the
property page of a shader), open the property page, hold down
Ctrl and Shift, then right-click on the shader name that is next to
an arrow (black text on white background). A little menu shows
up, choose Edit...(See Image Above Right)

The third line of the text file that opens, that starts with Refer-
ence, holds the ClassID of the shader. Use that in your script to
retrieve these shaders.

Another way to retrieve shaders is to traverse the Render Tree of
materials. This will be a lot more accurate than using the FindOb-
jects() command, because you can include search criterias in your
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code. However, traversing the Render Tree is a lot of work. Those
familiar with Python will greatly miss the os.path.walk() method for
traversing directory structures!

There are two ways to get the shaders connected into a shader.
One is to use the shaders property of the shader. If the collec-
tion it returns has a count higher than 0, then the shader has
other shaders connected. The other way is to loop over all the
parameters (inputs), to test if the parameter has a source. When
the parameter has a source, it means that something might be
connected, but can also mean there is an expression or a linked
parameter. So, after that, you have to get the source itself and
check if it is a shader.

Here | will present a technique to traverse the Render Tree, then
I will show you the code.

First, | start by creating a collection. This collection is used to
store individual shaders of a material. This collection is set to
accept the same item only once. Then the material, which is a
shader, is added to the collection, and will be the starting point of
the Render Tree traversal.

The actual traversal of the Render Tree then starts with a while
loop that will run as long as new shaders are found during an itera-
tion. The current collection count is recorded, then all the shaders
already in the collection are looked up. As it has been described
earlier, each parameter of the shaders is evaluated. If shaders are
connected, these shaders are added to the collection.

When all shaders of the collection have been tested, the collection
count is tested. If it has not changed from when it was recorded
(at the beginning of the while loop), it means that no new shaders
were found. Considering that all shaders of the collection have been
tested, it means there are no more shaders to be found, so all shad-
ers of the Render Tree have been collected and the while loop stops
there. Otherwise, if the collection count has increased, new shaders
have to be tested, and the while loop starts over again.




# Create empty collection to store shaders for each material
oShadars = xsifactory.CreateObject( "XSI.Collection” )
oShadars.unique = True
# Set default collection count value
iShaderCount =0
# Add material shader to collection
oShaders.add( oMat )
bLoop = True
# Start loop that evaluates each shader of the collection
while bLoop == True:
# Record the collection count
iShaderCount = oShaders.count
# lterate collection of shaders
for oShader in oShaders:
# lterate parameters of shader
for oParameter in oShader.parameters:
# Check if shader input has source (something connected)
if not oParameter.source:
pass
else:
# Add source shader to shader collection
oShaders.add( oParameter.source )

# Check if shaders were collected, compare current collection count to
recorded collection count

if oShaders.count > iShaderCount:
# Maintain loop condition and start anather round of iteration
bLoop = True

else:
# If no shaders were collected, stop loop

bLoop = False
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An advantage of this script is that you can insert search criterias
once the collection of shaders iteration has started. For example,
if | wanted to get all the Image nodes, | would create an empty
collection (also set to uniqueness), then test the collected shaders
to see if they are image nodes (by getting their ClassID), and add
them to that collection. Below is a short version of the previous
script example.

# Create tool that provides access to shader ClassIDs
oDatabase = XSIUtils.DataRepository
#..... jump to loop
for oShader in oShaders:
# Get shader ClassID
sShaderlD = oDatabase.getidentifier( oShader, 3 )
# Compare the ClassID we got to the Image shader one
if sShaderlD == slmageShaderlD:
olmageShaders.add( oShader )

Now that you have all the Image shaders of the material, you
could loop over them to change parameters or get their clip.

XSIBATCH & RAY3

XSIBATCH is an important part of the rendering. While in
SOFTIMAGE XS], most will use only the render region tool, and then
make the final rendering using XSIBATCH. However, using scripting,
a lot more than rendering can be done with XSIBATCH. You can, in
fact, open a scene and edit it entirely through scripting. | find this very
handy when | have to deal with very large scenes, because it uses very
little memory and | don't have to wait for the GUI to refresh.

For example, | once had a scene that was so large that it would
crash while exporting to mi2. So | launched an XSIBATCH command
prompt, then ran a .bat file that had a command to execute a script.
The script had two commands: OpenScene() and ExportMIZFile().
Unfortunately, it also crashed, but it shows that with scripts you can
still interact with the scene without the interface.

To interact this way with SOFTIMAGE IXSI, you'll have to
write down two files. The first file is a batch file (a text file with
a .bat extension), and you’'ll need to write a script file execution
instruction. The second file is the script itself, with all the com-
mands you want to be run. You can also write any script you

want, it may not just be commands.
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Another use of scripting with rendering is to edit mi2 files. There are
several features of mental ray that you can take advantage of only with
miZ2 file rendering, like user-defined area lights, large BSP acceleration,
light maps, and so on. So instead of opening huge mi2 files in a text
editor, you might want to write scripts that would look for specific text
elements in the file and edit them, or add informations in certain areas.
Regular expressions would definitely be the way to go.

SYSTEM COMMANDS

Finally, let's briefly discuss system commands. System commands
consist of commands that you send from a script to an application.
This command is an instruction that the target application can
recognize, and arguments are provided with the instruction so the
task can be completed. System commands are a powerful tool to
handle tasks that require interaction between several applications,
operating systems. and computers across a network.

One use that | will discuss here is to fasten the conversion of .pic
files to .map files. Basically. with a script. you can tell mental ray to
perform a conversion in a directory of your choice.

First you need to import the os module. This is a big Python mod-
ule that gives a lot of functionality to handle files and directories, and
it is with this module that you send system commands. Then you
need to change the current directory, like you would do in a com-
mand prompt. Point to the appropriate location of the imf_copy.exe
application. When you send the system command, the script will
look for the application in the current working directory, no other.

Then. specify the directory where you want the conversion to
take place. After that, all you have to do is build the command that
will tell imf_copy to generate the .map file:

import 0s

# Change current working directory to point to imf_copy (be careful to choose
the good cpu)

os.chdir( ‘C:\\Softimage\\XSI_4.2\\Application\\bin\\nt-x86-p4’ )
# Define path where imf_copy will input the .pic file and output the .map file
sPath = ‘C:\\Temp’

# Specify file name to convert and file name to output

sinput = ‘myTexture.pic'

sOutput = ‘myTexture.map’

# Build command to send to imf_copy

# The command is identical to what you write in a SOFTIMAGE|XSI shell to
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perform the conversion
sCommand = ‘imf_copy ‘ + sPath + \\' + sinput + * * + sPath + ‘\\' + sOutput
# Send system command to imf_copy
0s.system( sCommand )

The problem with this command is that it will always expect the
same file to convert. This might not be ideal if you're working on
several textures at a time. What you could do is set up a script that
checks all the files in the directory and compare the modification
dates of both the .pic and .map files. If it finds a .pic newer than the
.map version, it performs a conversion.

So what we will do here is to list the content of the target direc-
tory, checl all files with the same name before any extension and
padding, and then check if the .pic version is newer than the .map
version. We will need another module called string, whose purpose is
to handle.. strings! The next piece of code is heavily documented, so
read those comments to easily follow the steps:

import os

import string

def runCommand( sPath, sPicFile, sMapFile ):
“" This function simply composes the final command to run,

using the path and file names provided.

Then it executes the command. “™

# Build command

sCommand = ‘imf_copy ' + sPath + ‘\" + sPicFile + ' * + sPath + \' + sMap-
File

# Send system command to imf_copy
0s.system( sCommand )

# Change current working directory to point to imf_copy (be careful to choose
e good cpu)

os.chdir( ‘C:\\Softimage\\XSI_4.2\\Application\\bin\\nt-x86-p4" )

# Define path where imf_copy will input the .pic file and output the .map file
sPath = ‘C:\Temp’

# Get direcltory entries (both files and directories)

aEntries = os.listdir( sPath )

# lterate directory entries




for sEntry in aEntries:

# Split file name into a list. This will seperate the various file name ele-
ments, using the dots in the name.

aFile = string.split( sEntry, *.")

# Check the created list to see if the entry has a pic extention. Logically,
the extension would be the Iast element in the list

if aFile[-1] == "pic":
sPicFile = sEntry

# We have to compose a fictive file name with a .map extention,
then check if that file exists among the directory entries

# But we have to determine if the file has a padding. To do this,
check the length of the list.

if len( aFile ) == 2:
# File has no padding, simply add the custom extention fo its name
sMapFile = aFile[0] + ".map’
elif len( aFile ) == 3:

# File has padding, so get the padding from the list and insert it
between the file name and the extension

sMapFile = aFile[0] + " + aFile[1] + ".map’

# Next steps are to check if the file name we composed actually
exists in the directory entries

# Here we have a pic file that does not have a .map version
if sMapFile not in aEntries:
# Call function that runs system command
runCommand( sPath, sEntry, sMapFile )

# Here we have a pic file that does have a .map version, so we'l
need to compare modifcation dates.

else:
# Gel last modification time
iPicTime = os.path.getmtime( sPath + '\\' + sPicFile )
iMapTime = os.path.getmtime( sPath + \\' + sMapFile )
# Compare modification dates
if iMapTime < iPicTime:
# Call function that runs system command

runCommand( sPath, sPicFile, sMapFile )

SOFTIMAGEIXSI TUTORIAL

CONCLUSION

Covering all aspects of rendering with scripting would have required
me to write a book. For example, we have not seen the scripting of lights,
textures, the FX Tree, reference models, text file input/output, image
clips and image sources, overrides, render farms (that alone would make
most of the book!), BatchServe, plus the countless other things related to
rendering. Perhaps that could be material for a future article ... do not
hesitate to send letters to the editor of HDRI 3D if you want it so!

Still, | hope this short article gave you some interesting scripting
ideas. Personally, | find that almost anything related to rendering
benefits from scripted tools, since it often involves many tedious and
repetive tasks. For example, disabling the reflectivity on hundreds of
materials that are all different can be time consuming, especially if you
have to do it many times. This can be shortened dramatically by using
the Render Tree traversal code | provided to iterate every shader in the
scene. Plus, | find scripting a fun challenge of logic and engineering.

On a last note, | invite you to check out my personal Web site's
script page, where you will find lots of rendering-related scripts, in
Python. Happy scripting! &

RELEVANT LINKS:

BERNARD LEBEL HOME PAGE: http://www.bernardlebel.com

BERNARD LEBEL SCRIPT PAGE: http://www.bernardlebel.com/
scripts.htm

PYTHON DOWNLOAD: http://www.python.org/download/

PYWIN32Z MODULE: http://prdownloads.sourceforge.net/

pywin32/pywin32-203.win32-py2.3.exe

SOFTIMAGE [XSI FORUMS AND RESSOURCES:
http://www.xsibase.com

SOFTIMAGE IXSI RESSOURCES: http://www.edharriss.com

SOFTIMAGE HOME PAGE: http://www .softimage.com

BERNARD LEBEL AFTER A FEW YEARS IN
GRAPHIC DESIGN, BERNARD MADE THE MOVE
TO 3D ANIMATION. HE HAS BEEN WORKING IN 3D
GRAPHICS FOR OVER FOUR YEARS. LIGHTING
AND RENDERING ARE HIS FAVORED AREAS. HE
WORKED IN VARIOUS STUDIOS LIKE MULITVET
MEDIA, TWIST!IMAGE, CINEGROUPE, ACTION
SYNTHESE, METEOR STUDIOS. HE HAS BEEN
DOING SCRIPTING SINCE SPRING 2003, AND
PYTHON SCRIPTING SINCE JUNE 2004. HE HAS
BEEN USING SOFTIMAGE|XSI SINCE DECEMBER 2001. HE ALSO CREATED
SOFTIMAGE|XSI TRAINING MATERIAL FOR 3DTUTORIAL.COM, AND IS
WORKING ON A SECOND SET.
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BY DEUCE BENNETT

The

or those of us who have been

working with computer graphics

since the dark ages, we remember
the painful difficulties of trying to create
fluid movements of camera, objects, and
characters. We didn’t have a Graph Editor.
All adjustments had to be made by seat-of
the-pants keyframe adjustments. We had
no way of determining how a change
would affect the flow of movement until
we created another preview. Making al-
terations such as slowing a move from full
speed to a stop without a jerk became a
frustrating ordeal. Only the very dedicated
geeks prevailed through these primitive
early developments.

While we were growing into full-fledged
animators, the software was also evolving,
and still is. Among the most valuable tools
we gained to make animators’ lives easier
was a device to help facilitate the perfection
of movements without requiring sacrificing
large portions of your day. We got a Graph
Editor. Then, that was improved upon when
we no longer had to separate channels of
animation with a string of nulls. We could
animate and control independent channels
in the Graph Editor. Oh, the happiness!

Amazingly, many Wavers who enjoy all
the other tools in their favorite software
still don’t know how to tap the power of
this great magic wand. It requires a little
understanding to learn how to ‘read’ those
curves and be able to spot rough spots that

:ﬁﬂ HORI 3D 1SSUE3

need first-aid. Also, it requires a chant, a
mantra, a ‘way of working’ to really make
smooth animations.

. The fewer the keyframes, the smoother
| the animation and the easier it is to control.

What many new users don't really un-

derstand is how to ‘read’ the curves for a

| smooth path, or when to use what kinds of

| curves. Also, many users don’t know what

controls you have in the Graph Editor that

| youdon't have anywhere else. That's what |
hope to impart to you in this article.

Animation, moving things around, in
LightWave is a straightforward affair. You
set the keyframes, the computer does the
in-betweens. Simple. What can separate
two animators is the smoothness of moves,
or the amazing timing that some skilled
artists develop. One tool that has become
indispensable, is the graph editor or curve
editor.

Back in the old days, you couldn’t set
keyframes for individual channels at dif-
ferent times. At that time, you needed
to parent anything that you wanted to

| make smooth movements with to several
| nulls — usually one null for each channel
that you wanted to separate. This made
for some interesting scenes, having to
keep all the nulls under control. Thank-
| fully, NewTek at the version just after 5.6,
LightWave gained the ability to separate all

the channels, and the null was free again!
OK, but seriously, the point of this is — if
you don't need a keyframe on a channel,
don’t put one. Remember the mantra. This
is the primary problem that many people
who do work in “autokey” mode run into
when trying to make smooth movements.
Make sure, if you are one of those who like
to use autokey, that you enable “Modified
Channels" in the General Options tab of the
Preferences. This way, whatever channel
you modify, that will be the only channel
you automatically keyframe.
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[Hide Toobar
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OK, let's move to the Graph Editor. First off, let me mention
one thing that you will need to keep handy. That is the option for
‘automatically filter static envelopes’. What this does is, if you select
an object, light, bone— and it has some envelopes (channels) that
only have one keyframe (making it not move), then that channel
will not show up in the Graph Editor. This is very handy when you
have several objects that you are working with, but initially, it can
be frustrating as you might not have any keys set for something
that you are just starting with.

[ [AionKey Possthiongh |
|| Lock Molion Keys in Time |
[ [MoveNoKeys Sel |

[+ | Track Item Selections |

[ [FXVakics hen seleted |

SCREEN SHOTS CAN BE DOWNLOADED AT WWW.HDRI3D.COM/RESOURCES/

[ DON'T SHOW ME SOMETHING THAT ISN'T MOVING )

OK, here is a very simple graph, total of three keyframes;
this is very, very easy to make smooth. A good reason why
is because three keyframes, honestly, by their very nature are
smooth. In a way, they are like a 3-point polygon and cannot be
non-planar, | suppose.

7w

e e

k BELL CURVE - REMEMBER BLOWING THOSE IN SCHOOL

LIGHTWAVE TUTORIAL

There are many times, however, that you have to use more
than three.

. -

Efl"‘,‘"'!‘?l-\ﬂ-.‘i SR Ty

Now, this looks fine, but to me, there is one bad area. That is
between the first and second keyframes. Here's where using the
TCB controls can smooth out a path.

|
:
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k AHH SMOOOOOTH

Just a little sliding and we have a nice ease to that keyframe;
adding a Tension of 1 to the last keyframe makes it all the nicer. See
Ease Out top of next page.
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THE GRAPH EDOITOR...

EASE OUT - NICE AND SMOOTH

N

Here is a camera fly-by graph that was a little more complex. All
| typically do is set my keyframes for “where | want to be at what
time"” — then smooth out the rough spots.

k TRUST ME- IT WAS ANICE FLY-BY

This turned out to be a very nice animation.

Now, another question that comes up from time to time
is, “when do | use the other types of curves?” Well, I'm an
old-timer (oh gosh, now it's in print!), so TCB is what | typi-
cally use. However, that being said, there are some absolutely
good reasons for the other options. Otherwise, why would
they be there?

ISSUE 3
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Here's a good example that | run into a whole bunch doing mili-
tary visualizations. The launching of a missile. PIC_0007.TGA

B ) e T T T N S Ry e e Ty ey 1 15T SV

MISSILE AWAY !!!

(Note: the Z channel was what was keyframed, but | copied it to a null
so that | could put it on the X channel for clarity) The motion of a missile,
slow to start and rapidly, very rapidly, accelerating, is just hard to get, if
not possible to achieve, with TCB curves. Remember our mantra — the
fewer the keyframes, the smoother the animation and the easier it is to
control. So here, my entire missile launch is two keyframes.

L

BLUE JUST DIDN'T READ WELL

The ‘trick’ is that they are Bezier keyframes. See Bexier Handlles top
of next page. With the Bezier handlles, it's far easier to achieve that very
slow speedup, ending with an acceleration curve. Bezier have handles
that you can really pull the curve in with. Hermite don’t have this, but
Hermite are good for smooth curves. Also, by setting the “Post Behav-
jor” to Linear, the acceleration that | set up continues forever.
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BEZIER HANDLES - AHH NICE

Stepped keyframes; above. this keeps our mantra going with
only needing two keyframes for an “on-off" type behavior. You
know we used to need three keyframes for this?

|
|
|
|
|

OK — I'm going to finish this off with a little “Stupid Graph Editor
Tricks.” | am a HUGE believer in the credo that computers are a
labor saving device. Yes, | know, | hear you all — trust me, you use
them right? They are. For example, let's say you have an animation
that you have already done and are happy with, but in the next
scene, you need to have that same motion reversed.

LIGHTWAVE TUTORIAL

L

You can’t do this in the Scene Editor, because it doesn't un-
derstand negative frames with mathematic offsets. Just select all
the keyframes of your animation, and choose “Numeric Scale”
from the “Keys" menu (See Choose Scale on next page) at the

\[[4[oacton ~]Xeyz | Fooorrts ~[Autois _~| Dspiay _~| Optos [ Unds [ Cancel |

T e

SELECT THEMALL

top. (See Numeric Scale on next page) Type in “minus one” (-1)
for your “Time Scale Factor” and you have reversed your anima-
tion. (See Flip It on next page) Then just move the keys (they are
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THE GRAPH EDITOR...

ilnmmmmﬂmnﬂ-mmam

|

‘ ([0 T —

CHOOSE SCALE BACK IN THE POSITIV

still selected) forward the length of your animation. (Bottom left)
Mine happened to be 150 frames. (Above)

WUMERIDREALE OF 1 OK — one last time saver. I do a bunch of muzzle flashes. I typically do

e T T T e T T ) them with a light (point light) for a flare and the illumination around the
gun muzzle, and an object that | have made that is shaped somewhat
“muzzle flash-like” — but the trick is, when the Lens Flare is at 100%
brightness, | want my Object to be 0% dissolved. Rather than use an
expression, | just copy and paste, then use math to finish it.

:;lnmmmmmm-ﬁz-ua;ﬂl
|

]
L]
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FLIPIT!

|

ORIGINAL
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NEED TO INVERT IT

Select all keyframes — select “Numeric Scale” from the “Keys”
menu. Enter “minus one” (-1) for “Value Scale Factor” — this ‘inverts’
the animation, but makes it travel from -100% to 0% and back.

INVERT

So, choose “Numeric Move” from the “Keys” menu and enter 1.0
for the value offset. There you go, two steps and you can invert an
entire curve.

That's all for this issue. Keep it true and I'll see you all around!! &

LIGHTWAVE TUTORIAL

MOVE IT BACK UP Y,

JACK “DEUCE” BENNETT Il IS A FREELANCE CGI ARTIST
WITHABACKGROUND IN PHYSICAL SPECIAL EFFECTS
FOR MOTION PICTURES AND TELEVISION. DEUCE HAS
BEEN WORKING IN THE FILM INDUSTRY HIS ENTIRE
& LIFE, AND HAS SUCH MOVIES AS ROBOCOP, LONE-
' SOME DOVE, AND JIMMY NEUTRON: BOY GENIUS TO
| HIS CREDIT, AS WELL AS TV SHOWS LIKE WALKER,
TEXAS RANGER. DEUCE HAS BEEN USING COMPUT-
ERS SINCE HE WAS 9, AND STARTED OFF WRITING HIS
OWN GRAPHIC PROGRAMS. HE IS A UNIQUE COMBINATION OF PHYSICAL
KNOWLEDGE AND VIRTUAL KNOW-HOW.
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BY ERIC 5. KELLER

DISAPPEARING/REAPPEARING ACT:
ANIMATING TEXTURES IN MAYA

hen | create an animation in

Maya, | always keep an eye

on making things easy to
change down the road. To that end, | use
the connection editor, expressions, and set
driven keys as much as possible, and as
few keyframes on the time line as | can get
away with. When I'm animating textures in
complex hypershade networks, as you'll
see in this tutorial, this approach becomes
a real sanity saver. If | were to just set keys
on various attributes in a complex texture
network, I'd be sure to end up hunting for
these keys in a zillion nested panels when
changes become necessary.

The goal for the animation in this tutorial
was to have a character “beam in” or reveal
itself in a scene as a plane moves down
the Y axis. Sort of my own variation of the
Star Trek transporter beam, but with a few
twists. The effect is created almost entirely
with animated textures on a character that
is a single polygon mesh.

First, let's take a look at the character
shown in figure 1. | have created a very
simple polygon model of a little dog
in a space suit. She is a single piece of
polygonal geometry, including her eyes.
This model is not ideal for extensive
character animation, but she’ll work just
fine for demonstrating animated textures.
She's based on my dog Daisy, who in real
life also looks perpetually worried.

I will setup the textures so that as a
NURBS plane moves down in the Y-axis,
she will begin to appear out of thin air; ev-
erything above the plane will be visible and
everything below will be invisible. When |
was developing the idea for this animation,
it occurred to me that one way to achieve
this effect would be to animate a ramp
on the transparency channel of the dog's
shader. However, | didn’t want to animate
the color channel of the shader, just the

:ﬁﬂ HDRE 3D I1SSUE3

FIGURE 1-ASCREENSHOT OF THE SPACE DOG,
INSET IS APHOTO OF HER INSPIRATION

transparency. Furthermore, the color would
have to be mapped to the UVs on the body
in one way, and the transparency would
be mapped in another. So, to avoid this
problem, | set up multiple UV coordinate
sets for the different texture channels.

SETTING UP MULTIPLE UV SETS

1[ assigned a Blinn texture to the model
and then spent some time mapping the
UVs in the UV texture editor. The result is a
pretty standard UV texture map, which you

can see in figure 2. It's not the most efficient
map in the world but it works well enough
for this demonstration. | won't go into detail
on creating these UV texture coordinates
in this tutorial since | believe this topic has
been covered in plenty of others.

2] assigned a Photoshop Texture to
the Blinn shader for the color and the
specular color channels. One of the new
developments in Maya 6 is a node for
creating a Photoshop file texture with lay-
ers for selected channels. | recommend
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FIGURE 2 - THE UVS FOR THE MODEL AS SEEN IN MAYA'S UV TEXTURE EDITOR
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FIGURE 3 - A SCREENSHOT OF THE RAMP THAT IS
o, CONNECTED TO THE TRANSPARENCY CHANNEL

FIGURE 4 - RAMP IS CONNECTED TO THE SAME UV
SET THAT CONTROLS COLOR TEXTURE PLACEMENT,

MAYA TUTORIAL

checking out Maya help to see how to do
this. If you're using an older version of
Maya, you can use a more old-fashioned
approach with multiple image files, just as
long as you end up with file textures for
the color and specularity channels.

Once | had the textures painted and

mapped on my dog model, | renamed
this UV set by choosing (in the modeling
menu set) Edit Polygons>Texture>Rename
current UV set, and typing in the name
“dog_color” in the dialogue box.

4In the Blinn texture assigned to
the model, | created a ramp for the
transparency channel. In the texture
option box, | made sure it was set to
“Normal” as opposed to “As Projection”
or “As Stencil.” | wanted the ramp to be
black and white with no interpolation.
Where the ramp is black the texture will
be opaque; where it is white, the texture
will be transparent.

| deleted the top color from the ramp
5 and set the other two to black and
white (the values should be O and I,
respectively). | arranged the colors in the
ramp so that the black position is at .5
and the white position is at O as shown
in figure 3.

To see how this ramp is applied, |

opened the attribute editor for the
Blinn texture and chose the transpar-
ency channel for the Hardware Texturing
preview. The default resolution should be
OK, but sometimes it requires setting to
medium or high to see it correctly in the
perspective view.

When [ did this, it became immediately

apparent that the ramp was mapped all
wrong. Take a look at figure 4 to see how
badly this came out. The new transparency
ramp used the same UV coordinates as the
color channel, but what | actually wanted is
for the ramp to cut across the model in an
even horizontal fashion halfway down the
model. To do this, | created a new set of UV
coordinates. | selected the model and chose
Edit Polygons>Texture>Cylindrical mapping,
and in the options | selected the check box

IssuE3 HDRI 3D




ANIMATING TEXTURES...

for “Create New UV Set.” | named these new
coordinates “dog_transparency.” Then, | as-

signed the ramp texture to this new set of
UV coordinates.

Under Window=>Relationship Editors>

Uv Linking, 1 chose UV-Centric,
which opens up a new dialogue box. On
the left side, it shows the UV sets, and
on the right side it shows the channels
for the Blinn textures and their assigned
textures. When the “dog_color” UV set
is selected, all the textures on the right
side are highlighted. [ selected the
"dog_transparency” UV set on the left,
and the rampl texture on the right. This
automatically disconnects the ramp from
the “dog_color” set and assigns it to
“dog_transparency.” Now the mapping
of the ramp on the model should look
more like what [ want. | then opened up
the UV texture editor to do some clean-
up on this UV set.

9The UV mapping for the transpar-
ency channel doesn't have to be
terribly complicated. | selected the UVs
and scaled them down so that they fit in
the upper right hand corner of the grid.
Any stray UVs caused by the mapping |
selected and cleaned up by moving them
in. You can see how the UV set looks in
figure 5. In the figure, | have the UVs
fitting roughly between 1 and O in U,
and .25 and .75 in V. Once this is done,
the upper half of the dog should be black
and the lower half white.

Rendering out a still using Maya's
software rendering should show the
bottom half of the dog as invisible. How-
ever, | noticed that, since there is a file
texture mapped to specularity, and this
channel is connected to the “dog_color”
UV set, the bottom half of the dog is
still reflecting light, like transparent
plastic. See figure 6. I'll get to that in
a moment. First, I'll describe how | set
up the controls for the animation of the
transparency channel.

FIGURE 5-ANEW UV SET HAS BEEN CREATED TO CONTROL
THE TRANSPARENCY MAP VIAA CYLINDRICAL TEXTURE PLACEMENT

FIGURE 6 - THE TRANSPARENCY RAMP IS NOW MAPPED CORRECTLY BUT
THE FILE TEXTURE IN THE SPECULAR CHANNEL IS CAUSING SOME WEIRDNESS




ANIMATING THE TRANSPARENCY TEXTURE

1OI created a NURBS plane and
scaled it so that, from the top,

the border encompassed the dog model.
What | wanted to do was to create
a relationship between the plane's Y
translation and the position of the black
color border on my transparency ramp. |
could have set some keyframes on to the
position of the black border on the ramp
in the attribute editor, but, as | stated
before, | wanted to control everything
by the Y translation of the plane. This
way, if | decide to change the timing of
the animation later on, | would only have
to change keyframes on the plane’s posi-
tion. To do this, | used the Set Driven Key
to establish the relationship between the
plane’s translation and the ramp’s black
color position.

11[ opened up the dialogue box
for “Set Driven Key,” which is
found under the “Animate” menu in
the animation menu set. | selected the
NURBS plane and chose “Load Driver.”
It would then seem logical to load the
ramp texture on the driven side of the
Set Driven key box, and then select its
color input position for the black border
from the list of driven attributes so as to
connect it to the translate Y of the plane
on the driver side of the box, but Maya
won't let you do this. The individual
color input positions on the ramp don't
show up in the attribute list when you
load the ramp in the “Driven” half of the
box (go figure!). The work-around | used
was to load the transparency ramp’s
placeZDTexture node in the driven part
of the box instead of the ramp texture
itself and use the plane’s Y translate to
drive the offset attribute on this texture
placement node.

1 So to do this, | selected the

NURBS plane in the perspective
window, opened up the Set Driven Key,
and loaded it as the driver on the left
side of the box. Then | opened up the
hypershade window and selected the
placeZ2DTexture node that controls the
transparency ramp texture. With this

selected, | pressed the “Load Driven”
button on the right side of the Set Driven
Key dialog box.

Then, in the side view window, |
13moved the plane up until it was
just above the top of my model. Next,
| went to the attribute editor for the
place2dtexture node, I typed in .75 for
the offset in V. Doing this will reposition
the ramp so that the entire dog is white,
which means it will render as transpar-
ent. In the Set Driven Key dialog box,
| selected the translateY channel for
the NURBS plane in the driver side of
the box and the offset attribute for
the ramp’s place2Dtexture node in the
driven side of the box, and then I hit
the key button on the bottom of the Set
Driven Key box. phew!

1 Next, | moved the plane down

until it was just below the feet
of the dog. In the attribute editor for
the ramp’s place2dTextureNode, | typed
.25 in the offset box, which repositioned
the ramp so that the entire dog is black
(meaning that the dog will render as
opaque/visible). Again | selected the
translateY channel for the NURBS plane
from the attribute list on the driver
half of the Set Driven Key dialog box,
and the offset attribute for the ramp's
place2dTextureNode node in the at-
tribute list on the driven half, and | hit
the key button on the bottom of the box.
Now a relationship between the plane's
Y position and the ramp that controls
the dog’s transparency has been estab-
lished. Moving the plane up and down
makes this apparent in the perspective
window - provided you have transpar-
ency selected as the hardware texturing
mode in the Blinn texture's attribute box.
A few test renders will also confirm the
relationship between the plane’s Y trans-
lation and the dog's transparency.

]5N0w. the transparency and the
color channels were rendering

the way | wanted it to, but the specular
reflection still showed up on the surface.
This makes it look as though the dog is
some kind of clear plastic that is being

MAYA TUTORIAL

filled in with color as the plane moves
down. It's a cool effect, but not what |
want. To address this specular reflection
problem, 1 thought about connecting
the same ramp texture that controls the
transparency to the Blinn's specular-
ity channel. However, the specularity
channel already has a file texture node
connected to it, and, furthermore, the
transparency’s ramp texture is the re-
verse of what | want!

If | were to go ahead and hook up the
same ramp that controls the transpar-
ency to the specular color channel of the
Blinn shader, the white part of the ramp
would make the dog both transparent
and give her a white specular color,
and the black areas of the ramp would
make her opaque but with no specular
color. What |
of this situation: specular
on the visible/opaque parts of the
model and no specular reflection on the

want is the opposite

reflections

invisible/transparent part of the model.
My solution was to first create a reverse
node in the hypershade (under General
Utilities), and then connect the ramp’s
outColor to the reverse node'’s input
connection. | did this in the hypershade
by middle-mouse-button dragging the
ramp node on top of the newly created
reverse node and selecting “other” from
the pop-up menu. This opened the con-
nection editor, where | connected the
ramp’'s outColor to the reverse node’s
input. So now | have essentially created
a reversed ramp that is controlled by the
Y translation of the NURBS plane without
actually having to create a new ramp
texture or any more set driven keys and
it will render the way | want it to.

16T0 complete the connection to the
specular color channel without
losing the specular channel's connection
to the file texture, | connected the re-
verse node’s output to the colorGain on
the specular color channel's file texture
node. This essentially layers the reversed
ramp texture on top of the specularity
channel’s file texture. Now where the
ramp is black, the specular file texture is
black, but where the ramp is white, the
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file texture shows up just fine. Figure 7
shows this part of the shading network.
Phew again!

INCANDESCENCE

As an additional touch, | wanted to
create a bright glowing beam at the
intersection of the plane and the dog
model. The setup will be very similar to
the transparency ramp, but since | wanted
a thin beam, | ended up creating a new
ramp texture for incandescence.

17To set this up, | created another
ramp in the incandescence channel
of the Dog’s Blinn texture. This new ramp
has a thin beam of green in the middle at
the .5 position.

18]ust as in the case of the transpar-
ency, | want this incandescent

beam to be mapped as a cylindrical
projection. The easiest way to do this was
to hook it up to the same UV set as the
transparency. | opened up the UV Linking
relationship editor in UV centric mode. |
selected the dog_transparency set on the
left and the ramp under the incandes-
cence on the right. Now, when | render
the scene, there should be a bright glow-
ing green band running midway around
the dog but, as of yet, the movement of
the plane does not affect the placement
of this band.

1 To fix this, | opened up the
9c0nnection editor and the hy-
pershade. | selected the placeZDtexture
node that controls the placement of the
transparency map and loaded it on the
left side of the connection editor. | then
selected the placeZDtexture node that
controls the incandescence ramp and
loaded it on the right side of the connec-
tion editor. On the left side of the con-
nection editor | selected OffsetV from
the attribute list, and then connected to
the OffsetV on the right side. Now the Y
translate of the plane controls the offset
of the incandescence ramp indirectly via
the set driven keys | already placed on
the transparency ramp.
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File texture to the
specular color
channel of

the Blinn texture

Reverse node to the
colorGain of the file texture

Ramp1 outColor to the ENENEA
input of the reverse node

Set driven keys from the NURBS plane to the ramp's offset

FIGURE 5-AVIEW OF THE HYPERSHADE SHOWING THE RAMP'S CONNECTION TO BOTH THE TRANSPARENCY
AND THE COLORGAIN ON THE SPECULAR CHANNEL'S FILE TEXTURE. NOTE THE REVERSE NODE!

MENTAL RAY

If you're using Mental Ray to render the
image, the render may abort and give you
an error such as “‘maya_placeZdtexture”
has no member ‘offset.” A quick work-
around that Mental Ray prefers, involves
using an expression on the position of the
black color of the ramp. (If you're using
Maya's software rendering engine, skip
ahead to step 23.)

2 | removed all of the set driven keys
Oon the ramp textures controlling
transparency, incandescence, and color gain
on specular color texture. | also went into
the UV texture editor and normalized the
dog_transparency set so that the UVs fit per-
fectly between O and 1 in both U and V. The
easiest way to do this is to select all the UVs
and, in the UV texture editing menus, choose
Polygons> Normalize UVs. Make sure that
“collectively” is checked and “preserve aspect
ratio” is unchecked in the options.

1Then, I moved the plane so that
2 it was right at the very top of my
model. In this case, that would make the
Y translation value = 6.885. | loaded my
transparency ramp into the attribute editor,

right-clicked on the position for the black
color on the ramp, and chose “create new
expression” from the pop-up menu.

ZZThe expression | entered was ramp1
.colorEntryList[2].position=nurbsPlane
LtranslateY*.14524. Why .14524? Well, | want
the position of the black color in the ramp to
be at O when the plane is at O and when the
plane moves to the top of the model (6.885),
I want the black color to be at 1. 1/6.885 =
.14524. . (I rounded). So now the black color
on the ramp should move with the plane just
like in the earlier setup, and this won't cause
Mental Ray to give up during the render. A
similar expression can be put on the color
positions of the incandescence ramp.

TEXTURING THE PLANE

The rest of this tutorial picks up from
step 19 and uses Maya’'s software ren-
dering engine instead of Mental Ray,
most of these following techniques
should work for both renderers.

So now I've solved my main problem.
Moving the plane up and down cre-
ates the effect of the dog appearing
or disappearing. However, the plane




FIGURE 8 - THE PRIMARY GRID TEXTURE ON THE OUT
GLOW COLOR OF THE PLANE'S SHADER

FIGURE 9 - THE SECONDARY GRID TEXTURE APPLIED ON
TOP OF THE PRIMARY GRID TEXTURE

MAYA TUTODRIAL

looks kind of dull, so | decided to add
an animated texture just to make it look

more interesting.

| assigned a surface shader to the
23 plane and made the color black and
completely transparent (i.e. white in the
transparency channel).

241 assigned a grid texture in the out
glow channel.

I made the line color green and the
25ﬁ|ler color black because | wanted
to make a border that just illuminated the
edges of the plane. Since my plane was

perfectly square, a grid texture worked
just fine.

| set the U and V width of the grid
26t0 .005. In the placeZ2DtextureNode
for the grid, | set the repeat UV attributes
to 1. Rendering this shows a nice glowing

green border that goes around the plane.
See figure 8.

I went back to the grid node and,
2 in the filler color, | created another
grid node. This second grid has a duller
green for the line color and black for the
filler color.

28 In the second grid’s placeZdtexture
node, | set the repeat UV attributes

to 16. Now the plane renders as a grow-
ing green grid with a bright border. See
figure 9.

The last detail | wanted to add to this

glowing grid plane was a pulsing glow that
moves across the plane as it moves.

2 | went back to the first grid and,
9in its color offset channel under
the color balance attributes, | created a
V Ramp.

3OI made the ramp black on the top
and bottom, and created a dim
gray band in the middle.

31 In the color channel for this band, |
created a fractal texture.
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ANIMATING TEXTLRES...

FIGURE 10 - THE FINAL ANIMATION SHOWING THE SPACE DOG BEAMING IN

32T0 make the fractal green, | went
into its attributes and chose a dim
green color for the color gain under the
color balance attributes.

When | rendered this scene, | had a
green glowing grid with a bright fractal
beam in the middle. You can see this is
the final rendered stills of the animation
in figure 10.

To animate the fractal beam mov-
33ing across the grid, | used a set
driven key again to set up a relationship
between the NURBS plane’s Y translation
and the V offset of the placeZDTexture
node that controls this dim green fractal
ramp. This time, | set the V offset to O
when the plane is at the very top of the
dog and | when the plane is down to
about the bottom of the ears.

34] selected this placeZDtexture
node, opened the graph editor,
selected the offsetV curve and chose
“cycle” for the pre and post infinity op-
tions under the curves menu. Now the
green band will constantly zip across as
the plane moves down, and once again,
this motion is directly related to the Y
position of the plane, so | can keep the
keys on the timeline to a minimum. If

o
u
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I change the rate at which the NURBS
plane moves down, this glowing beam
will speed up or slow down accordingly.
Mental Ray does not like the connection
to the offsetV on the place2dTexture
node, so you may want to substitute
this with an expression like the one
described earlier.

Setting up this effect takes some work,
but the animation is easy. All you have to
do now is set key frames on the NURBS
plane’s Y translation. If | decided that | want
the dog to disappear instead of appear, |
can just animate the plane moving up
instead of down.

I hope you got a few ideas from this tuto-
rial on how to economize future animations
using set driven keys, multiple UV sets,
the connection editor, and some simple
expressions. Although the techniques in this
example are fairly specific to this animation,
you should be able to figure out how to use
similar techniques to create different effects.
Some ideas that come to mind include a glass
filing with a colored liquid, or some kind of
vaporization ray. A QuickTime movie of the
final animation is available in the resource
section of the HDRI3D Magazine website at
www.hdri3d.com/resources.html. &

“ERIC S. KELLER HAS
. SPENT THE LAST SIX
" YEARS AS A SCIENTIFIC
ANIMATOR AT THE HOW-
ARD HUGHES MEDICAL
INSTITUTE  IN  CHEVY
CHASE MARYLAND. WHEN
HE'S NOT RENDERING MO-
LECULAR DATA AT WORK,
HE ENJOYS CREATING
ANIMATIONS AT HOME IN WASHINGTON DC. HIS
TRAINING IS IN MUSIC AND ART. HIS PRIMARY
TOOLS ARE MAYA, ZBRUSH, PHOTOSHOP, AND
AFTER EFFECTS. INSPIRATION COMES FROM
HIS WIFE ZOE, THEIR TWO DOGS, AND WAY TOO
MUCH TV.
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BY ALEXANDER SHAREEF

| here is no one correct way of doing something. This is one of the most important

things a Visual Effects artist can learn. As a Visual Effects artist, you must learn

o this early on, because in order to create amazing magical spectacles, the simplest

of ways are often the best. It may not be the greatest way of doing it, but generally it's

the fastest...and most importantly...it works.

It's the simple little tricks that are the foundation and building
blocks for all special effects work. Small little things that are
broken down then reassembled together to create something
far greater than the sum of its parts. A Visual Effects artist is
really just a problem solver, figuring out ways of fooling the eye
into believing it's something completely different...something
wonderful, instead of something simple.

Take, for example, the scrolling texture on a cylinder trick...at
first, you might think something as simple as that wouldn'’t be
convincing as anything...but for a long while, it was the main
way of doing an engine’s thrusters for a plane or spaceship.

If you take this cylinder trick one step further and pull down
the sides of the cylinders, it will give the appearance that the
texture is now moving outwards from the center in a circle.
This is an incredibly simple but useful trick, and one that | use
all the time at work; it is very good at making things look like
ethereal energy.

What I'm going to do in this tutorial is show you this particular

trick, and in doing so, make some kind of magical portal. Hope-
fully, this should be a good introductory tutorial to the world of
effects. Though it's actually far easier to do this trick in other
programs like Maya or 3ds max, I'm going to take you through
it in LightWave, since that's the package | started learning with
some six years ago and I'm partial to its coolness.

TUTORIAL STEPS

First of all, let's make a cylinder like in (Fig 1). I've kept it to 24 sides so
as to keep the roundness of the circle, and six segments gives us plenty
to play with for UVs later (Fig 2).

Delete the top and bottom faces of the cylinder as shown in (Fig 3).
We won't need those.

Now before proceeding any further, let's make sure to ap-
ply some UV-mapping to the cylinder. Create a new Texture
Map (Fig 4), and call it something meaningful. | named it
“CylinderUVs.” Don't forget to change the mapping type to
Cylindrical (Fig 5). For those that don't know what UVs are, what

Hummﬂ;: Disc Tool
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FIG 02 —YOUD NEVER BELIEVE THIS CYLINDER WAS THE PORTAL

\_FIG 1 —CREATE ACYLINDER
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SCREEN SHOTS CAN BE DOWNLOADED AT WWW.HDRI3D.COM/RESOURCES/

LIGHTWAVE TUTORIAL

FIG 03 — DELETE THE TOP AND BOTTOM

FIG 04 — CREATE AUV TEXTURE MAP

=

'Create UV Texture Map

k FIG 06 — CREATE ANEW SURFACE

we've done here is basically just wrap a flat texture around the
cylinder. This is useful, because no matter what happens to
the geometry, that texture will conform to each of the faces
and can be unwrapped at any time. Imagine it as if you've just
wrapped an invisible piece of paper around a coke can with
superglue...even if you bend or squash the can; the paper will
bend with it since it's glued to the sides. This is really the heart
of the effect, and with UV scrolling can be very powerful. It's
simple, but quite effective.

To better see this, how about we actually texture the cylin-
der. Hit q to bring up the surfacing panel, and call the surface
something meaningful, like “Portal_Surface” (Fig 6). Open up the
Surface Editor, and proceed to add a texture to the Color channel.
Choose “UV" as the projection type, and then under the UVMap

exture Editor - Portal_Surface - Color

FIG 07 — FOR NOW, JUST USE “FRACTALREFLECTIONS"

FIG 08 — WITH ATEXTURE ON, IT LOOKS MORE LIKE A PORTAL ALREADY

FIG 09 — SELECT EACH ROW IN TURN AND SCALE THEM QUT

tab, choose the one we created earlier, “CylinderUVs.” For the mo-
ment, just choose the standard “FractalReflections.tga” that comes
with LightWave as the texture (Fig 7). We'll be creating our own
custom texture later, but use this one for the moment so you can
get an idea of what's happening with the UV texturing (Fig 8).

So, now comes the interesting part.. Let's do exactly what we imag-
ined earlier and squash the cylinder down and out. Grab the bottommost
points, and scale them out a bit (Fig 9). Take the next row up and do the
same, this time pulling them down a bit as well. Continue this until you
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PORTAL PLASMA

have something similar to (Fig 10). Modiify it further, pulling in the top-
most points (now the centermost) to close that gap in the middle as much
as possible without stretching the UV mapping too much. Hopefully by
the end of it all, you'll be left with something like in (Fig 11).

Did you notice how the texture stayed ‘super-glued'’ to each of the
faces, and conformed to the new shape? It now appears squashed
down, and looks somewhat portal-like! The cool thing is we can
unwrap the UVs at any time to go back to their original flat shape.
Or better yet, how about scrolling/animating the UVs so that they
appear to flow from the center outwards?

There are a couple more things that need to be done first before we
can move on to the UV scrolling. First of all, 'm going to paint the ver-
tices with some colors. This is completely voluntary, and not necessary
for the final portal, but as you'll see along the way it is quite a useful
and easy tool for adding gradient-like colors quickly to the portal.

Under the “Map>Weight&Color” tab, select “Vertex Paint.” You'll
be greeted with what at first seems a very complicated window, but
it's actually quite straightforward (Fig 12). Under the edit menu, select
“Create Vertex Color Map,” and give it a name like “Portal_VertexMap”
(Fig 13). Now everything is pretty much already set up the way we
want it to be, but I'll run through the important parts of the tool.

What the Vertex Paint tool does is exactly what it sounds like
— it paints colors onto the individual points of the geometry. So, by
doing this, each point will have their own color information that can
be used in addition to the texture map.

Under the Color tab, you'll see the Brush Size set to 20, which is
OK for the moment and can be changed on the fly by dragging the
right-mouse button. You can select “Front,” which tells it just to paint
on the faces that the brush touches. Leave the brush shape as a circle.
Further down, the Color Map that should be selected is the one we
just created, namely “Portal_VertexMap." Keep it as RGBA, which
will allow us to paint in the Alpha channel as well as Color channels.
The “Color/Point” paint mode is perfect for what we're going to do,
though please experiment with the other modes. The "REP" next to
paint mode indicates anything we paint will replace whatever vertex
information was already there. This can be set to Add, Subtract, or
Erase, though keep it on Replace for this tutorial. The strength of the
brush is akin to how much pressure you might normally paint with,
so 100% is fine for us.

Finally, there are the actual colors that you can choose to paint
with, either in RGB or HSV whichever you prefer. Our portal is go-
ing to be a blue base, but feel free to add in some purples and even
greens to break it up a bit. I'll leave this up to your artistic eye, but |
just painted each row a slightly different hue of blue. When you're
done painting, you should have something like (Fig 14).

This next bit is important...before you close the Vertex Paint, don’t
forget to click the “Save” button next to the Object name. The changes
you've made here to the vertex colors will not be applied to the object in
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‘ FIG 12 —THE VERTEX PAINT OPTIONS

Create Yertex Color Map

| - S e
v N Poital VertexMap !

FIG 13 — MAKE A VERTEX

COLOR MAP TO USE )

Modeler unless you do this. Also, you won't be able to see any changes
in Modeler until you go into the Surface Editor and under the Advanced
tab, select the “Portal_VertexMap" as the Vertex Color Map.
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LIGHTWAVE TUTORIAL

Vertex Paint

FIG 15 — USE A GRADIENT TO GIVE THE EDGES A TRANSPARENCY

Now we're pretty much finished with the modeling stage, so
let’s transfer over to Layout and start with the fun stuff! First off,
we need to set the groundwork for alphering out the edges. At the
moment, the outer and inner edges of the ‘portal’ disc have harsh
edges, but we want to give the illusion of magical ethereal energy.
Don't forget to save your model now.

Import the portal into Layout, and set up the camera so you can
do a quick test render using VIPER. Right now, it just looks like
a disc with a texture on it. There are a few ways we could give
the edges a nice transparent look; one is to create a texture in
Photoshop to use as a map, another way would be to use one of
LightWave's built-in gradient features. Let's do that.

Open the Surface Editor, and click on the T button next to Trans-

parency on our “Portal_Surface.” Choose a gradient as the Layer
type, and then in the input parameter choose Distance to Pivot
Point. If you refer back to (Fig /1), you'll notice that I set the top of
the geometry at 0,0,0 in Modeler...this will put the pivot point right
at the center of the portal, perfect for this gradient. If you haven't
already done that, do so now.

So, what we want is for the center to be transparent, then fade in
slowly and fade out again around the edges of the portal. Back in the
Surface Editor, change the end of the gradient to 2. If you've been
following along closely, you'll find your portal is 4 meters across, so
the radius is 2 meters from the center. Put 100% Transparency at Om
and 2m, then 0% at 0.4m and 1.75m, and this should create a gradient
like the one in (Fig 15).

You should have something like in (Fig 16). Not bad, so now how
about giving it some movement. Unfortunately, up until LightWave
[8] there was no inbuilt UV-Scrolling tool...But...there is a crazy little
trick that can emulate it for us.

Go to the Image Editor and select the “FractalReflections.tga” file that
we're using. So far, we've only used this texture as a temporary file.
In Photoshop, or your favorite paint program, create a texture that is
512x512 in size and fill it with black. Save this image as “Black.tga.” Back
in Layout, replace “FractalReflections.tga” with this “Black.tga” file.

The reason we're doing this is because we're basically just going to
project another image onto this one, so it is becoming like a canvas to
paint onto and so doesn'’t need to have any colors. Since everything's
gone black it won't matter if, under the Editing tab, we take the bright-
ness down to —1 to make sure this image doesn't effect what we're
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PORTAL PLASMA

about to project onto it. The portal is now completely black. Under the
processing tab, add a filter from the list and choose “Filtered Image.”
This will allow us to basically project an image on top of the portal, while
being able to keep the UVs, but the good thing it is animatable. Also,
check the “Animate Filters” button, to allow animation on the texture.
For some reason, LightWave [7.5] and earlier versions forgot to keep
this checked when you saved the scene, so you need to recheck it when
opening up the scene.

Double click on the Filtered image, select the Y-axis, and in the Tex-
ture tab, keep the projection to Planar, but also make sure the axis is on
Y here as well. Now, for the image, choose anything you wish. | always
say the best thing to do is to create custom textures, so follow along in
the side-tab guide and make your own texture. Alternatively, just select
“FractalReflections.tga” again.

Either way, whichever texture you decide to use here—either
your created version of “Portalfractal Oltga” or the generic
“FractalReflections.tga’-the next step is to get it animating. Add a NULL
object, and call it “UV_Animate.” Back in the properties for the Textured
Filter, make this NULL the Reference Object. Now, try moving about
the NULL object a bit, and you should see that portal animates. . .In fact,
keyframe it at 0,0,0 on Frame O, then move it to Frame 100 and set it to
2,0,0. This should give a nice portal-like movement.

So hopefully by now you should have a nice looking portal that
moves inwards. You could end here, but there’s never really a need to
stop working on something when you can modify and tweak it to make
it better and better. There’s always something more you can do to the
effect. Let me show you a nice little trick that will bring this piece alive
even more than it is now.

Save your model and scene, and then load it back up in Modeler.
Change one of the viewports to the UV Texture display like in (Fig
17). OK, here’s the cool thing. What do you suppose would happen
if we started to move about the UVs on the texture? Try it out.
Move each UV about a bit, giving it a jittered look, but make sure
not to touch the outer UVs (Fig 18). Spend a bit of time doing this
right, and you'll end up with some excellent results.

Save the model, and back in Layout do another test render.
What you should find is that by jittering the UVs slightly, we've
given the animation some randomness, so it doesn't appear to just
move straight into the middle of the portal, but jitters about on the
way. This is a really nice trick, and is especially useful for creating
ethereal energy (Fig 19).

I've shown you a nice little trick, but think of all the other cool
things you could keep adding to this now that you have the
groundwork...particles, lens flares, flashes, glows, a portal ring to
hold the energy...the list is endless ...

To finish off real quick, let’s do just one more thing. In Mod-
eler, select the portal, copy it and move the portal up slightly
by about 50mm on Y. You should have two portals now, one
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FIG 19 — THIS JITTERS ABOUT THE TEXTURE AS IT MOVES NOW

slightly above the other. Put the second portal in another layer,
and give it a new surface, such as “Portal_Surface2,” and copy
over all the attributes of the first surface to the new one with
Surface Editor. In Layout, let's change a few attributes. First
of all, in order to get this new surface to work independently
of the first one, you'll need to also make a copy of that black
texture and call it “black_512_2.tga.”
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|
CREATE YOUR OWN PORTAL TEXTURE

n Photoshop, create a new image at B e & TR T g % Untied 1 & 100% Bockground capy 3, )
512x512. From the Filters menu, choose [ = T3 =

the Render>Clouds. You'll see that this is |
instantly tileable; this is because we created
it at 512 in size (Fig A). There are so many
ways to make textures, but I'll just show you
here how you can create one very quickly
and easily using Photoshop’s built-in filters.
Next, choose the Distorf>Glass and play
around with the settings if you wish. Here's the good part — run the Render>Difference Clouds,
making sure to have black and white as your two primary colors. Do this four‘limes, and you
should have something like in (Fig B). Save this now as “PortalFractal_01.tga.”

Not bad, but we can tweak it a bit more. Duplicate this layer onto another Iay%ar and run the
Render>Difference Clouds one more time on this new layer. Change the blending mode of the
new layer to Darken, then hit Ctrl+E to merge these two layers together. Bring up the contrast a

little, and it should look like (Fig C). Save this one as “PortalFractal_02.tga.”

| Do the same Textured Filter trick to this new black texture, but
| this time use the “PortalFractal_02.tga" texture that you created in
Photoshop using the side-panel tutorial (Fig 20). What we're going to
do is to add some more depth to the portal, so rather than it being this
single flat texture, it will have much more substance to it when we use
two separate and distinct images layered on top of each other.

Your object should now be made up of two layers, the first (the lower
portal) and the second (the upper part). Select the second layer in Layout
and in the Object Properties set the Object Dissolve to 50%. This will
make it dissolve out, so we can see the lower portal underneath it. Also,
to help in this, copy the Color channel into the Transparency channel.

| Make it additive with the transparency gradient and set it to about 30%.
As a final last touch, you could add some fractal noise and ripples into
the Color channel just to give it a bit more depth. By the end of it all,

i you'll probably have something similar to (Fig 21).

I hope you've learned something from this tutorial, and if it's
anything at all, then it is to just play around a bit and keep at it
until you've got something you're really satisfied with. Remember,

projects are never finished, only abandoned! &

If you have questions or comments contact Shareef at:
shareef@dx-digital.com

ALEXANDER SHAREEF HAS BEEN A PROFESSIONAL
VISUAL EFFECTS ARTIST FOR THE LAST THREE
YEARS, AND CURRENTLY WORKS AT BIOWARE CORP.
IN CANADAAS A LEAD VISUAL EFFECTS ARTIST ON AN
AS-YET-UNANNOUNCED PROJECT. HE WAS INSPIRED
TOENTER INTO 3D GRAPHICS AFTER WATCHING BAB-
YLON 5, AND IS COMPLETELY SELF-TAUGHT. THOUGH
HE HAS USED ALL THE MAJOR 3D APPLICATIONS,
INCLUDING MAYA, 3DS MAX, AND HOUDINI, HE PRE-
* FERS THE ONE HE STARTED OUT WITH, LIGHTWAVE.
HE MOVED TO CANADA FROM ENGLAND WITH HIS WIFE, AND IS FASCINATED
WITH ANCIENT CULTURES SUCH AS ANCIENT EGYPT.

\ FIG 21 — JSING YOUR OWN TEXTURES MAKES A BIG DIFFERENCE ) |




BY PETER RATNER

Setting up the Human

Model for

O |

f you have read other tutorials
about rigging,
probably familiar with the usual
disclaimer that says something like

( INTRODUCTION

then you are ‘

this, “This way of doing a rig is just
one of many and is not meant to be the
way of creating a rig.” Yet, even though
this has become a cliché, it is true. There are
many ways of rigging and it is up to each
animator to find the one they prefer.

The following tutorial will show you how
to rig a biped character. It is a method that
produces a rig that my students and | find ‘
easy to work with and does not require
any programming skills to set it up. Piyush
Patel from Digital Tutors teaches this system. ‘
Since Maya makes generous use of icons, |
it is a rig that fits right in with its interface.
The skeleton is driven with foot, hand, and
other icons representing parts of the human ‘
body. For example, when you want to move
the right arm, grab the right hand icon and
move it. If you want to lift the left leg, then
move the left foot icon up.

Of course, before you can Dbegin
rigging you will need a human or
human-like model. If you are unsure
how to model one, then you can refer to
my book, Mastering 3D Animation, Znd
Edition. It shows each step for building
a subdivision or polygon model. Even
though the book is non-software specific,
you can adapt the method to smooth
proxy modeling.
quads or faces, you can simply delete

Instead of spinning |

edges and reconnect the vertices to make
new configurations.

=

Animation

Figure | shows an abbreviated series of
steps for achieving a smooth proxy head.
The advantage to starting with a box rather
than extruding edges and gradually build-
ing a head from parts of it such as the eye
area, nose, lips, and so on is that the box
gives you an instant volume. One may ask
why not start with a sphere since a human
head appears to resemble that more than
a cube. A sphere is vague and difficult to
measure, and lacks distinct areas of asso-
ciation. The eye finds it difficult to focus on
any one part of a sphere. However, a cube
is easier to split into various components,
less difficult to perceive in perspective,
and appears to have the added dimension
of weight. It is a much quicker method of
modeling because instead of starting with
details, you work with a general shape
and gradually create more detailed areas.
Proportions are easier to gauge when you
already have the mass of the head. Unlike
the edge extrude method; box modeling
creates a head with a lot less polygons
(faces).

One of the most invaluable contributors
to 3D modeling has been Peter Levius. His
site can be found at:

www.3d.sk/

It is by far the best place to find template
photos of humans. This is an incred-
ible site and definitely the Internet’'s most
important resource for 3D modelers and
texture artists. | hope more artists support
this site so that it can continue to grow.
My students and [ find his site so valuable
we are more than willing to promote it
without making any money from it.

BREVIATED MODELING STEPS
FROM MASTERING 3D ANIMATION, 2ND EDITION

( SETTING UP A SKELETON )

In human anatomy, the skeleton carries
the weight and serves as the foundation
for the body. The muscles are attached to
the skeleton with tendons. By contraction,
muscles move the bones. The skeleton in-
fluences the form of the figure underneath
the skin, fat, and muscles. In some parts of
the body, the skeleton is always discernible
on the surface, while in other areas, it only
appears only during certain movements.

While 3D humans share some similar
structural characteristics with real-life ones,
the differences are much greater. The
skeleton in animation is used mostly for
movement and rarely adds structure to the
body. Unless you are using a sophisticated




muscular/skeletal system for animation,
your character's bones will most likely
look like simple geometric shapes. When
these are rotated, they affect the polygons,
splines, or NURBS mesh.

PREPARING FOR RIGGING A
HUMAN MODEL

Each software package has its own meth-
ods for rigging a skeleton. Since Maya is

considered the most popular and widely used
3D animation software in the movie industry,
it behooves us to use its system of setting up
a human for animation. If you are using some-
thing different than Maya, you may still find
the following instructions useful by adapting
them to your own method of working.

Before starting the actual rigging process, a
few routines will be covered that are going to
be utilized later. It is important to understand
these concepts so that later when they are
applied to a real skeleton setup they will not
be too difficult to understand.

CREATING BONES WITH
THE JOINT TOOL

Maya's tool for creating bones is called

the Joint Tool. Joints are Maya's way of
identifying the area where two or more
bones are joined. The joints have a spheri-
cal look to them while the bones appear as
elongated pyramid forms.

Select the Joint Tool for making bones by
going to the Animation
Menu Set on the top left
of your screen. Select

1

——

the menu item Skeleton
> Joint Tool or select the
Joint Tool from the Ani-
mation shelf. In the side 2
view, starting at the top,
click four times, moving
the Joint Tool down in

the same progression 4 5

/

FIG. 2 - USING THE JOINT
TOOL TO MAKE A SIMPLE LEG SKELETON

as seen in Figure Z.

STEP 2 |

When you are finished clicking four
times with the Joint Tool, press the Enter
button to complete the simple leg skeleton.
You can now adjust the size of each joint
with the Move Tool. If the joints appear too
large or small, go to the Display menu and
select Joint Size.

(TOGGL]NG LOCAL ROTATION szs)

Each joint has a local rotation axis that
can be adjusted so that the bones rotate
along the correct axis. For example, when
you rotate the fingers into a closed fist, you
would not want them to twist sideways
along the wrong axis. To manually rotate a
joint’s local axis, do the following.

STEP 1

Select one of the joints on the leg skel-
eton. Select Display > Component Display >
Local Rotation Axes. The joint should now
display its x, y, and z orientation.

FIG. 3 - DISPLAYING THE LOCAL ROTATION AXES

Make a shelf icon for this command.
Make sure the Animation shelf is in the

foreground. Press the Shift and Control
keys down while selecting Display > Com-
ponent Display > Local Rotation Axes.

STEP 2

Click the Select by Component Type icon
in the Status Line to turn on the component
selection mode and also click the Miscella-
neous (?) mask icon in the Status Line. Right

MAYA TUTORIAL

click the Miscellaneous (?) mask icon and

turn on Local Rotation Axes (Figure 4).

B 7

X Local Rotation Axes
[Cimage Planes

FIG. 4~ THE COMPONENT MODE AND THE
MISCELLANEOUS MASK ICONS FOUND

IN THE STATUS LINE

You can toggle back and forth between
component mode and object mode by
pressing F8.

STEP 3

In component mode, click on one of the
three lines (y is green, z is blue, x is red).
They are located inside each joint after
selecting it and then going to Display >
Component Display > Local Rotation Axes.

After selecting the local axis line,
choose the Rotation Tool (press “e” on
the keyboard). You can now rotate the
three axes manually. For example, you
may want to rotate the Y-axis of the joint
so that it points in a straight line with
the bone below it. When you are done
orienting all the local rotation axes, press
F8 to get out of component mode. Hide
the local rotation axes of each joint by
selecting the joint and pressing the shelf
icon for Display > Component Display >
Local Rotation Axes.

SELECTING A SKELETON'S
HIERARCHY WITH A MEL SCRIPT

When you want to create movements

such as fingers curling into a closed po-
sition simply by rotating one joint, you
can use the following Mel script: “select
-hi”. By selecting all the connected bones
and applying this script, you will be able
to rotate the end joint, which in turn ro-
tates the rest of the bones. You can also
use this to bend a spine.

IsSUE 3 HORI
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STEP 1

Open the Script Editor and type “select -
hi". Highlight the two words that you typed
and middle-click to drag the Mel script up
to the Animation shelf.

STEP 2

Select the first joint located at the top
of the leg bone chain. Choose the Rotate
Tool. Rotate the leg bones in the side view.
Notice that all the bones remain static while
being rotated around the first joint’s axis.
Undo the rotation.

STEP 3

While the first joint is still selected, click
the “select -hi” Mel script button on the
Animation shelf. The rotate tool should
now switch to the joint on the opposite
end at the tip of the foot bone. Rotate
this joint and watch how the other bones
curl in. Later on when we curl the fingers
closed for Set Driven Keys, we will use
this Mel script. In your Shelf Editor, add

an icon to this Mel script.

An IK handle is an animation tool for
arranging joint chains. When you click
on two joints, it creates a wire running
through the joint chain. The IK handle
that is created at the second joint can
be moved, which in turn poses the entire
joint chain. An IK solver automatically

CREATING AN IK HANDLE
ON A JOINT CHAIN

determines how to rotate all the joints in
the joint chain.

STEP 1

Select the IK Handle Tool from the
Animation shelf or go to Skeleton > IK
Handile Tool. In the side view, click on the
first joint at the top of the leg skeleton,
then click again on the third joint located
where the ankle would be. This should
create a line between the two joints with
an IK handle located at the ankle joint
(Figure 5).

HDRI 3D 1s5UE3
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Handle
Tool

FIG. 5 - CLICKING ON THE FIRST AND THIRD JOINT WITH THE IK HANDLE TOOL CREATES A WIRE BETWEEN
THE TWO JOINTS. THE IK HANDLE AT THE ANKLE JOINT IS USED TO MOVE THE LEG.

STEP 2

In the perspective window, select the IK
Handle at the ankle joint and move it around
with the Move Tool. Notice how the upper and
lower leg bones resolve themselves according
to how much the foot bone is raised.

QELIMINATING CHANNEL OPTIONS )

The Channel Box contains quite a number
of attributes such as translate, rotate, scale,
and visibility. Some of these, such as scale
and visibility, are not necessary for skeletal
deformations and can be cleared out of the
Channel Box, leaving room for you to add
your own attributes.

Create an icon that can be used later to drive
the IK Handle. Since we do not want the icon
to render, it will be made from a curve. Go
to Create>NURBS Primitives>Circle. Move the
circle down and behind the foot (Figure G).

NURBS
Circle

O

FIG. 6 -~ADDING A NURBS CIRCLE THAT
WILL DRIVE THE IK HANDLE
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FIG. 7 - OPENING THE CHANNEL CONTROL

General Editors > |
Rendering Editors

BOX IN ORDER TO ELIMINATE NONESSENTIAL
ATTRIBUTES IN THE CHANNEL BOX
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FIG. 8— OPENING THE ATTRIBUTE BOX FOR ADDING
CERTAIN PROPERTIES TO THE CHANNEL BOX
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FIG. 9 - GOING TO THE SET DRIVEN
KEYS OPTION BOX
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FIG. 10 - THE SET DRIVEN KEYS OPTION BOX

STEP 2 |

Press “Control a” several times until
you see the Channel Box on the top right
of your screen. Notice all the attributes
for the circle. We will now delete some
of these.

STEP 3

Make sure the NURBS circle is selected
and go to Window > General Editors >
Channel Control...(Figure 7). On the left
side of the Channel Control box, select
only the Scale X, Y, and Z, plus the Visibility
attributes. Click the Move button on the
bottom of the box. You should now see
that the Channel Box on the far right no
longer exhibits those attributes. In the next
part we are going to acld our own attribute

to the channel box.

Adding the following attribute to the
Channel Box will lead us into the next sec-

ADDING ATTRIBUTES TO
THE CHANNEL BOX

tion on creating set driven keys.

STEP 1 |

While the NURBS circle is still selected,
go to Modify > Add Artribute.. (Figure 8).

STEP 2 |

In the Add Attribute box, under the New
tab next to Attribute Name, type “FootLift”
next to Attribute Name. Under the Numeric
Attribute Properties, next to Minimum,
type -5. Next to Maximum, type 10. Next
to Default, type 0. Click OK. The Channel
Box on the top far right should now show
the new attribute “FootLift.”

( CREATING SET DRIVEN KEYS )

Set Driven Keys are useful for making
attributes drive the values of other attri-
butes. In other words, when you change
the value of one object (the driver) it will
affect the behavior of another object
(the driven).

MAYA TUTDRIAL

STEP 1

Select the Animation Menu Set on the
top left of your screen. Go to Animate > Set
Driven Keys > Set > Option Box (Figure 9).

STEP 2

Notice that the Set Driven Keys box
has a Driver at the top and a Driven on
the bottom. The Driver is going to be
the NURBS circle and the Driven is the IK
Handle. Select the NURBS circle and click
the “Load Driver” button on the bottom
of the Set Driven Key box. The attributes
from the Channel Box are now listed on the
right next to the name of the NURBS circle.
Select the attribute called “FootLift."

STEP 3

Select the IK Handle located at the ankle.
In the Set Driven Key box click the “Load
Driven” button. The IK Handle should now
be listed under the Driven heading with its
attributes on the right. In the Set Driven
Key box, select only the “translateY” at-
tribute next to the IK Handle (Figure 10).

STEP 4

In the Set Driven Key box, press the
“Key” button on the bottom left. Select the
NURBS circle and in its Channel Box on the
top left of your screen, next to FootLift,
type 10 and press Enter. The NURBS circle
and the IK Handle can be selected within
the Set Driven Keys box by clicking on their
names. Select the IK Handle and move it
straight up to bend the leg. Press the "Key"
button on the bottom left of the Set Driven
Key box. Close the Set Driven Key box.

STEP 5

Select the NURBS circle and in its Channel
Box, highlight the name “FootLift.” Click with
your middle mouse button in one of the view
windows and drag left and right. Notice that
as you hold down the middle mouse button
and drag back and forth, the foot raises and
lowers according to the changing values of

issue 3 HDRY 3D ?:




the NURBS circle in the Channel Box next to
the highlighted attribute “FootLift.” This is a
simplified version of using Set Driven Keys.
Later, when we rig a character, we will use
this method to drive the feet and hands.

(WEIGHTING AN IK SPLINE HANDLE)

The spine of a character should have a
lot of flexibility and be easy to control. This
section shows how to set up an IK spine
with an IK Spline Handle. All the control
vertices of that IK Spline will be manipu-
lated with a cluster deformer. Weights will
then be assigned to the control vertices for
easier handling of the spine.

STEP 1

Create a new scene and select the Joint
Tool. In the side view starting at the bottom
of the window and working up toward the
top, click seven times to create six bones
and seven joints. They should resemble a
human spine. You can move the individual
joints and also display them smaller by go-
ing to Display > Joint Size.

STEP 2

Go to Skeleton > IK Spline Handle Tool
> Options (Figure 11). Under the IK Spline
Handle Settings, next to Number of Spans,
click 3. Using the IK Spline Handle Tool,
click on the bottom joint and then the
top joint of the chain. This will place an IK
Handle at the top joint. In order to get a
better view of just the spline and its control
vertices you can hide the joints by going
to your view window's Show menu and
turning off Joints. You should now see a
curving line that follows the path of the
hidden joints.

SITER 3

Press F8 so that you can select the spline’s
vertices with component type. Draw a se-
lection around all the components in your
side view. You should now see the control
vertices along the spline highlighted. Select
the bottom three vertices and go to Deform
> Create Cluster. This will give you a cluster
handle that will move the IK Spline and

=L
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its hidden skeleton. Select the next two
vertices and go to Deform > Create Cluster.
Select the top vertex and go to Deform >
Create Cluster. You should now have three
cluster handles along the spine that can
control the way it bends (Figure 12). The
next step will show how to get the base
of the spine to remain stationary while the
rest of the spine can be moved.

STEP 4

To add weights to the vertices, select all
the control vertices and go to Window >
General Editors > Component Editor.. Fig-
ure 13 shows the three cluster handles
listed under the Weighted Deformers tab.
Under “cluster!1” next to “cv[0]” type in O
for its weight. This is the bottom control
vertex, and with a weight of zero it will
not move, thus giving stability to the spine.
Next to “cv[l], type .3 for its weight. For
“cv[2], type .6 for its weight. Under “clus-
ter2” next to “cv[3]" type in .7. For “cv[4]"
type in .8 for its weight. For “cluster3™ next
to “cv[5]" type in 1 for its weight. Close the
Component Editor.

STEP'5

Press F8 to get out of component
type and back to object type. Bring up
the Perspective and Outliner windows.
Rename the cluster handles. Name
“clusteriHandle” to “SpineBase.” Change
“clusterZHandle” into “SpineMiddle.” Re-
name “cluster3Handle” "SpineTop”. Move
the three cluster handles around to test
the way the spine bends. You can always
go back to Windows > General Editors >
Component Editor...to change the weights
of the vertices. Twisting the shoulders
back and forth is done with the IK Handle
at the top of the spine. Select it, and in the
Channel Box, locate “Twist” and highlight
it. Using your middle mouse button, drag

back and forth to twist the spine.

STEP 6

Sometimes the cluster handles are
difficult to select. To fix this problem,
select one of the cluster handles and go to

Display > Component Display > Selection

Skin Constrain Character

| Joint Tool )
| IK Handle Tool 0
IK Spline Handle Tool | |i
| Insert Joint Tool
Reroot Skeleton ‘
Remove Joint
Disconnect Joint
Connect Joint mj
Mirror Joint 0|
Orient Joint |
Retargeting | 4
Set Preferred Angle O

| Assume Preferred Angle 0

| Enable IK Handle Snap
Enable IKFK Control
Enable Selected IK Handles

FIG. 11 — SELECTING THE IK SPLINE HANDLE
TOOL OPTIONS. THE SPINE JOINTS ARE
SHOWN ON THE LEFT

FIG. 12 - THE IK SPLINE CONTROL VERTICES
AND THE THREE CLUSTER HANDLES
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FIG. 13- IN THE COMPONENT EDITOR, FOR EACH

CONTROL VERTICES, USE THE SETTINGS SHOWN
HERE TO GIVE EACH OF THEM A DIFFERENT WEIGHT.
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FIG. 16 - BINDING THE SKIN (MESH) TO THE SKELETON
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FIG. 17 - SELECTING THE PAINT SKIN WEIGHTS TOOL
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Handiles. This will put a small plus sign on
the “C” cluster handle. Press F8 to go into
component type and click the + sign (Selec-
tion Handles Component) at the top of the
screen. Turn off all the other component
types. This will make it easier to select the
cluster + handle. Draw a selection around
the selection handle. Move it behind the
“C" cluster handle so it will be easy to find
and select. Repeat these steps to make
selection handles for the other two cluster
handles (Figure 14).

(B]NDING SKIN (MESH) TO A SKELEI’ON)

The purpose of this exercise is to show
how you can smooth bind a skeleton so
that it influences its surrounding mesh.

STEP 1

Using your previously created spine
setup, go to Create > Polygons Primitives
> Cylinder > Options. In your Polygon
Cylinder Options box, put in the settings
seen in Figure 15 and click Create.

STEP 2

Turn on subdivision mode for the cylinder,
or go to Polygons > Smooth > Options and
set the Subdivision Levels to 3.

STEP 3

In wireframe view, select the root joint and
Shift-select the cylinder. In the Animation
Menu Set, go to Skin > Bind Skin > Smooth

Bind (Figure 16). Using your Selection

FIG. 15— SETTINGS FOR THE POLYGON CYLINDER

Handles and the Move Tool you can now
deform the cylinder.

Sometimes the mesh will not deform cor-
rectly at the joints. This can often be fixed
by correcting the weights. These determine

PAINTING WEIGHTS

how much influence a particular bone exerts
on the mesh. The Paint Skin Weights Tool is
used to correct faulty weights.

STEP 1

Make sure that Smooth Bind on the
mesh is still working. If moving Selection
Handles does not affect the mesh, then
go to Skin > Bind Skin > Smooth Bind.
Sometimes switching back and forth
between subdivision and low poly mode
will detach the skin so that the skeleton
no longer affects the mesh.

STEP 2

Select the cylinder and go to Skin > Edit
Smooth Skin > Paint Skin Weights Tool >
Options (Figure 17). The Paint Skin Weights
Tool will now allow you to vary the weights
on the cylinder.

When you select a joint under the
Influence heading, it shows where and
how much influence it has on the mesh.
White means the most (100%) while
black mean none or zero weight.

Press the “b" button to adjust the size of
your brush. If you do not want to change
the weight influence of a particular joint,

IssuE3 HDRI 3D
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then select it under the Influence heading
and click the Toggle Hold Weights On
Selected button. Now you select the joint
above or below it and paint weights without
changing the one that has “(Hold)" on it.

Under the Paint Weights heading next to
Paint Operation you can use the following
options:

REPLACE — This replaces the skin weight
with the weight set for the brush.

ADD - You can increase the influence of
nearby joints with this option.

SCALE — The power of far away joints
can be diminished with this option.

SMOOTH — If you want to blend any
rough transitions between weights, then
use this option.

CLAMP — Allows you to hold certain
settings for specified weights so that you
never go below or above a particular mini-
mum and maximum range.

FLOOD — This will apply all the brush
settings to all the skin weights for the
particular joint that is currently selected.
For example, if you have the Replace
value set to zero and you click Flood, it
will put a zero (no weights) influence on
that part of the mesh. The selected joint
will no longer have any effect on any
part of the cylinder.

STEP 3

When you are done, test the weights by
moving the Selection Handles.

C RIGID VS SMOOTH BINDING )

There are two ways to bind a skeleton
(Figure 18). You have already seen how to
use the smooth bind option. Rigid binding
differs from smooth binding because the
control vertices of the mesh can only be
assigned to one joint. For example, if you
have a cylinder with two joints of equal
length inside it and you select rigid bind-
ing, half the points on the mesh will be
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assigned solely to one joint, while the other
half will only belong to the second joint.
This results in deformations that appear
crimped at the joints. Using a Paint Cluster
Weights tool will resolve most of these
problems (Figure 19). Rigid binding also
allows one the option of applying lattices
to control unwanted crimping at the joints
(Figure 20).

On a smooth bind object, each CV
(control vertex) can be assigned to multiple
joints. The mesh around joints that are
not being moved will also exhibit points
around them being moved. This can result
in some strange folding around joints
that often includes a ballooning effect on
the mesh. Setting the weights, such as is
shown in Figure 17, will often fix these
type of troubles. Rigid bound rigs perform
faster than smooth bound ones.

C

Continuing our work with the cylinder

IMPROVING DEFORMATIONS
WITH FLEXORS

that has the spine joint setup, you will
detach the skin from the smooth bound
rig, bind it using Rigid Bind, and then edit
the rigid skin with a Flexor.

STEP 1

Select the cylinder and go to Skin > De-
tach Skin. The joints will no longer deform
the mesh.

STEP 2

Bind the skin by selecting the root joint
first, and then Shift-select the cylinder.
Co to Skin > Bind Skin > Rigid Bind. Test
the rig by moving some of the selection

handles and observe the crimping at the
joints when the bones rotate more than
45 degrees. Undo all the movements of
the selection handles so that the cylinder
is in its upright position.

STEP 3

Go to Skin > Edit Rigid Skin > Create
Flexor...(Figure 21). Accept the default
settings in the Create Flexor option box.

FIG. 18 - RIGID SKINNING VS SMOOTH SKINNING

FIG. 19 - EDITING THE RIGID SKIN WITH
THE PAINT CLUSTER WEIGHTS TOOL

FIG. 20 - EDITING THE RIGID SKIN
WITH A LATTICE

Test the effect of the lattice by moving
the selection handle. If you still see too
much crimping, then select the Lattice,
right-click and select Lattice Point. Now
select the lattice points in front of the
area that is crimping. Use your Scale
Tool to increase the distance between
the lattice vertices on the Y-axis. Test
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FIG. 22 - SELECTING THE PAINT
SET MEMBERSHIP TOOL

the deformation again and keep scaling
the lattice points on the Y-axis until you
are satisfied. You can hide the Lattices by
going to your view window's menu and
selecting Show > Deformers.

( PAINT SET MEMBERSHIP TOOL )

Sometimes when you perform a rigid
bind, certain vertices are assigned to the
wrong bones. The Set Membership Tool

allows you to reassign these vertices to the
correct corresponding bones.

Select the cylinder and go to Deform
> Paint Set Membership Tool > Options.
In the Paint Set Membership Tool option
box underneath Select Set to Modify, click
on the joint sets until you see the vertices
highlighted in your perspective view. After
setting the size of your brush (b), you can
Add, Transfer, or Remove to change the
membership of individual points so that
they correspond with the correct bones.
You can find these under the title Paint
Operations, and they do the following:

ADD — This removes the painted vertices
from their current set and adds them to the
selected set. Just select the joint set that you
want to add points to and paint over the area
that contains those vertices. They will then
become part of the set that you had selected.

TRANSFER — The Transfer operation does
the same thing as the Add operation: it re-
moves the painted CVs or vertices from their
current set and adds them to the selected set.

REMOVE - The Remove operation
removes the painted CVs or vertices from
the sets they belong to, so any deformers
or joints do not influence the CVs vertices.

After experimenting with the Paint Set
Membership Tool, move the selection
handles to see if you get any improved de-
formations at the joints. If you see that your
are still getting some crimping then leave the
cylinder in its bent condition and go back to
the Paint Set Membership Tool. Find the joint
set at the deformed area. Add or Transfer the
vertices, and see what happens. You should
be able to fix the problem.

Now that you have had a chance to
experiment with the various operations that
will be used for rigging a character, the next
part of this tutorial, in the next issue, will
have you rig a biped model. During the pro-
cess, if you find certain aspects confusing,
then just review this beginning section titled
Preparing for Rigging a Human Model. @
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BY ANOREA CARVEY

EINKINGIOBIECISIOIPARIICLES

PART 1 - FX LINKER

nce in a while, something that is ohtWave 30:7.0e 0 T e e
inherently very difficult and time il Scene
consuming is made fantastically g
simple with the right tools. FX Link and FX Graph.
Linker are two tools that are easy to use ls"d’ﬁ"’
with little fiddling needed, yet have many :'
parameters that can be adjusted to suit your VIPER
needs. And they produce some impressive 2
and fun animations to boot! - Ef =
v ——

Basically, you set up a particle emitter and
then “link” an object to the motion of one
of the particles. The difference between FX
Link and FX Linker is that with FX Linker, an
object is cloned and each clone is linked to a
different particle. The rotation and spin of the
clones can be adjusted to give a natural look.
However, you can't specify which particle an
object is linked to, whereas with FX Link you
can. As always, there are pros and cons for
each of the tools, and which one you use will
depend on what you need to do. In this issue,
we will discuss the use of FX Linker and next
issue we will look at FX Link.

SET UP THE HV EMITTER

BEGIN WITH CLEARED SCENE
ADD HV EMITTER

R FROM PAR BRO R

1. Open the ParticleFX Browser - Scene /
FX_Browser (in the Tools/Dynamic section)

2. Select “HV Emitter” from the “Add” drop-
down menu (It must be clicked twice, once
to access the drop-down menu, another
time to select the HV Emitter.)

3. Close the ParticleFX Browser

A NOTE ABOUT STEP 2
Either the HV Emitter or the Partigon Emitter
will work, but Partigons that are not assigned
fo an object will render as tiny sparks, whereas

particles from the HV Emitter will not be visible. If
you want the sparks, no problem, but by changing
the Surface Transparency of the Partigon Emitter

to 100%, they become invisible. SUGGESTED PARAMETERS FOR PARTICLEFX EMITTER TABS
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LIGHTWAVE TUTORIAL

CREATE PARTICLE MOTION

4, Select the HV Emitter

5. Open the “ParticleFX Emitter” window
- Scene / FX Property

6. Change the following default settings:

Generator Tab- Size Effect = Size (no change)

Particle Tab— Resistance = .25

Motion Tab— Vector (m/s)y =3 m
Explosion (m/s) = 3.0

Etc. Tab— Gravity (m/s2)y =-1.0

7. Close the “ParticleFX Emitter” window

Particles should emit over 60 frames.

me—— P e T T T —— . gy NOTES ABOUT STEP 5
o] 5 i o= R GENERATOR TAB :
PARTICLES EMITTING FROM EMITTER OBJECT One weird quikk occurs occasionally. If one
of the other “Size Effect” parameters is selected,
sometimes only one particle apparently is emitted,
and makes it seem like nothing is happening.

PARTICLE TAB

Under the Particle Tab of the ParticleFX Emitter
window; there is a parameter called “Particle
Lifetime.” This determines how long (in frames) a
particle “lives” or is visible and moves. To prevent
the object that is linked to a particle from stopping in
mid-air, make sure that the Particle Lifetime is equal
to or longer than the animation.

SET UP SCENE

8. Load Object
Use LightWave / Objects / Food / Apple
(or Banana).

9. Move Camera
Suggestion: y = 1.25m; z = - 5m
(Create keyframe at frame “0").

10. Size HV Emitter

Select HV Emitter.

Change “Scale” - Suggestion x, y, z, = .1(Items
/ Size). (Create keyframe at frame “0".)

11. Save Scene
(There is no Undo for FX Linker, so to
“undo” the linking procedure, you have to

SIZED EMITTER OBJECT reload the scene)
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LINK PARTICLES TO OBJECTS

12. Select Object (apple or banana)

13. Open the ParticleFX Linker window
(Scene / FX Linker).

15. Enter parameters as indicated in Figure
at Right.

16. Click "OK.”

Now when you run the animation, 31
apples (or bananas) should all fly up in the
air like they were kicked by a donkey (see
picture Lower Right). Pretty darn neat!

If you want to change the behavior of
the objects, you have to reload the scene
that you saved prior to the linking proce-
dure and enter different parameters for
the particle emitter (Step 6) and/or the FX
Linker (Step 15).

So, it's just that simple! You can play
around with the parameters to get different
particle effects and link any objects you
want. Just think — fluttering leaves, gold
coins, flying debris. I'm sure you'll come up
with something. &
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SUGGESTED PARAMETERS FOR THE PARTICLEFX LINKER

LINKED OBJECTS AT FRAME 30
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FINAL RENDER

TRACKING THE

LEARNING CURVE

BY ANDREA CARVEY

Most of us spend a good deal of our
lives learning stuff. As human beings, we
are really good at learning stuff. In fact,
when there isn't enough stuff for us to
learn, we start making stuff up (baseball
statistics, the IRS tax code, or crop circles,
for instance). Unfortunately, that doesn’t
mean learning is always easy, or fun. As
luck would have it, the stuff we need to
learn is usually the hardest and least fun,
whereas stuff like trivia sticks in our minds
like cat hair on ice cream.

The kind of information that we really need
requires work and time, and this goes double
for the 3D world. In other words, there is a
learning curve involved in gaining informa-
tion. | have experienced a number of different
learning curves in my travels through 3D-land,
many of which are familiar to most people.

First is the classic linear “curve.” Techni-
cally, it is a slope rather than a true curve. It
has a beginning, a rigid, focused, path, and
(sometimes) an end, and can be either steep
or gentle. Most academic institutions like
to think that their students experience the
“gentle” variety...the long, excruciatingly
slow, positive, linear slope. However, usually
it is just long and excruciatingly slow.

Next is the simple curve, of which there are
two basic types: convex and concave. With
the “convex” curve, you quickly acquire a lot
of information. “Whoa! Piece of cake. This
is great! This program is really intuitive and
easy to learn. | think I'll recommend it to all
of my friends.” However, soon you discover
that you are bogged down in the Swamp of
Despair, cursing yourself for even mention-
ing it to your dog and hoping against hope
that all your friends were suddenly struck
with amnesia so that they won't all launch a
kamikaze attack in retaliation.

With the “concave” curve, on the other
hand, you are lost in a thick fog for... like
forever... not knowing where you're going,

HDRi 35 15ssULE3

wondering why the heck you started this
journey in the first place. The more intel-
ligent among us bail out at this point and go
back to playing Doom, but if you can hang
on, gradually, the fog begins to lift. Then,
like a greased pig down a laundry chute, the
fog is swept away and you are left blinking
in the sudden brightness and clarity.

Then there is the “on-the-fly” learning
curve. This is usually the norm for me. Gen-
erally, this learning curve is extremely short-
term, very specific (I only need one feature
of a program for the particular project I'm
working on), and intermittent — not unlike
the dashed line on the highway.

A close relative of the “on-the-fly” curve
is the “re-tooling” curve. This is the result of
erratic, insidious, re-packaging of familiar
territory that companies feel the need to
do every so often. It is one of the great
questions of human existence. When new
versions of the software are released, why
is it that all the tools you knew by heart have
been randomly moved about or put into to-
tally different menus? Do they think that we
might not notice? | have a feeling that they
know we enjoy learning and so they figure
that they will give us a good time.

Most people are familiar with these
types of curves, which are generally
considered to be “positive,” meaning you
are increasing your knowledge. However,
that isn't always the case. Less familiar are
learning curves that are, at least in part,
either flat (meaning that no matter how
much time and effort you put in, you just
can't learn anything), or negative, mean-
ing you are losing it. At that point, it's time
for some inspiring TV, like Jerry Springer,
where at least you can regain some sense
of intelligence by comparison.

The most frustrating type is that of the
Figure 8 learning curve. Not only are you
fooled into thinking you are making prog-
ress, but you are actually re-learning the

same exact stuff over and over again, in a
never ending loop.

With the Spiral curve, you eventually do
succeed, even though you have to learn stuff
again and again. Fortunately, you learn a little
bit more each time you go over it, eventually
making progress.

Related to the Spiral learning curve is the
Spirographic learning curve. Named after the
Spirograph toy, the type of learning described
by this curve is characterized by multiple
periods of learning and loss. However, rarely
are you learning the exact same stuff over
again, although it often overlaps with stuff
you already learned. The resulting curve is an
interesting, beautiful, and complex pattern.

The learning curve that strikes the most fear
in my heart is the X-treme curve that | call The
Creat Leap. While not technically a curve (not
even a steep slope), it is the mental equivalent
of BASE jumping — where no intelligence or
learning is involved, you just have to DO it
I have experienced the 3D equivalent of this
adventure more than once. Just thinking
about it gets my heart racing! Now that | think
of it, | bet | would prefer BASE jumping! In
fact, leaping into empty space from the top
of a remote, rugged, desert cliff and plum-
meting toward a jumble of ragged boulders
sounds infinitely more enjoyable than some of

-

the learning curves | have had to endure! &
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